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Quick Start

Multitrack Recording Steyp-by-Step

ZDT Y IRT— RE(E, MixPre-3M ZFEMNSEDH LT, BEFWEPLIOA - -DHREZ(FUH
TIHSEED, [RFTYT)IARFYT L V\DVY—K | REEZEEERKRLET .

HERE(CRE 9 DEFMRIBIR. CTTHRNSINTWVBFIEOZHBICDWTI(E, COI—Y—HA RORESR
SBEE0N,
Ld—F1 >0 %BHBICIS:

1. ERO#EH
PRKEB1IDDEIR. DFD/NNFTU—NUSB-COEESNTHREBELET .

2. MixPre O&EFREZAND,
EAEOERAAvVFEZIASA RLTONICTSBDE MixPre hCEILET .

3. A—FaA V-
NAOOTA> . SAZHEROSA U LNVHAREZAEDOA>TY b - Sv v OCEHRUE
3_0

4, AWV RITA>DEH \
BAIEOAY RIA> - Svv Il ANYRIA> - TSOEEHUET,

5. BEHAAT a0 FPO%(RH
Class10 SD H— REE@/\RILOXOY MIEAULET .

(A) = ZHYTFTDE. A menu BRRSNET.

LR Stereo

0

Presets

LR Stereo

ft 0O

Project

LR Stereo

ft 0O

USB Drive

Reverb Metronome * Shortcuts

Outputs Record SD Card System

(B) @00 (Ryh -7740>) #AVITFTDE BER—DCTPIOLRATEEY,
Info: By bOER—ZHZRL., Ry MTKDOREODR-—ESZIERETETFI .
(C) SD Card > Edit > Format &9vFUZEY,

(D) OK #Hvw LT, SDH—RIA—Xv hZETLET,

Warning: SD B— RARDIARTDOF—IhHESTNZET.

E) M £5YTULT. K—LBEEICROET,
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6. JO>IT U SOER
(A) = =EHIYITUET,

(B) Project > New &9V ULZET,

New Project
~1 Back

Sample Rate
48K

Import

Create Recording

(C) I TO> U bD&aiZEATDIEHIC. Name IV ITUET,

ZRiZ A URRIFNIE. MixPre-3M (& Songl, Song2 W2 le 1-——0%—LhZzBEM(CERL
ia_c

(D) BRuJge/al — hh'S Sample Rate #9vFUE T,

(E) Create 9wV FUZEY,

7. ANZERET D

(A) mMELIEWRSYOICHEETDF oL JIEBLET. BIXE. trackl (CERE T D5
A/ J1=BUFET,
Fv ) VEHEARRENE T,

1: Track 1
- 1.

ce | M
Linking
Normal | Off

(B) Input #9v L. HPI>O—4%ZEBILTA>TY - V- &BRUET,
BIRATRERA TS 3> 1 Mic, Line, Aux In, USB In

(C) D7 A LBRZEZVEETDINAIOTA> ., DI ZOMOHEMDIHE(F. Phantom Zi#EIR
UET,

(D) Back Z29vJ LT, FyYRIVEHEICRDEFY,

(BE) hSYINEBFIBEHIC. AAmMESIYVIUET., RSV INRT—LASTNDE. KBICED
NnEXI,




10.

11.

12.

13.

(F) A RARRKREA>DTY hEMLKIESHIC, FTBRYVICFv>RIL JTHITT—5—"EH
0dB (CRRBFETEILEY. RIC Gin (Fyr>RILEELE) #9v L. HP T>O—4%EILT
A>Ty NREERABLET,

Fr>ILe JTDUT LED (FA>TY b - ILRNILOARSS(CEU TRE(CSITIDDT, @&
VIRESLANIDNANETNTUVBEE([E. FZEICEITIDIFEMARELRBLSICTAERHELT
<IEEW, ADESHEREVNESF. BLZEUT, XMV -5 35dB. SA>Y—XRS
10dB ([CHAZELTL 2S00\,

Info: 74 JHAEE— RE, BEEPHDE 5BEICKRTUEY,

(G) Ry k- T7AO>&EAYVITU. BE 2 R—HEXRRSE. Pan, Reverb, Air, IR EEREDHE
BEEARRLTLSIESU,

(H) F—R—=R. RSAVXS >, OV E1—AHENRE RFT L AT RZER L TLBIBEA. Linking
EBHCUET,

(1) M 25T U TR—LBEICRDET,
A O/ —LDRE
(A) = &BIVTUET.

(B) R—=%i@EL T, YT AZa1—DHD Metronome &9V IFUEI, COHIAZ1—FFR
FUEAY RIAZTARND ) —LDTLEI—BEELZENTEET,

(C) Count-in 245w F93&, LO—FT 4 >IBBEIORYIDED T, A O —LHEDLS
WHD>Y NTBIWEBRTECEET,

(BE) A bO/—AFZREEB®D 2 R—ZHICHD During:-- IV ITI3E. LWDXA RO —L%k
B<HERETEEI., ATF>3> 1 Count-in, Record, Play

F) M55y Fs3E. AROS—LDTLEL—BHIEEDET.

G) Jd 299 T LT, MusicControl A=1—(CADET, =T, [ #5YTTBEAR
O/ —LBBEMCIRDFET,

Info: A bOJ—AlE. MixPre ¥ record, E1zl& play (CAD71z8. (During..5%E TRIED T
FIRENTWVWDE—R) [CHIRENET,

IR—LBEENS, FEULEVWRSY IESHHRIRRSNTND (Rec V—ASNTHESEMCSE
TW3) CEzHRULET. Ffeo A—F—E1—-TA>2Tv bANILEHERLET,

RECRZ>ZHL., TS, BERZRBLTIEZ,

STOPRA > —ERIHRT LESFELELET.,. 5 EHIT & (2EH). FENET—YDRE
yCcOry—kUxEd,

PLAY RG> Z#| I & BELFET. BEFRICKSYILANIL, UN=T, T7—, ) vO,
=1—heEETEFY,
Info: T7—WRDHD Sy IEF—E(C1 hSYIRRIFTTY,

(AT>3>) BEZARETLIO-—FTa>2>J&PDELUEVSE. Ij &S w T L. History %z
v TFUEYT, HPI>I—4%EIELT Restar Song &/ \1 S+ MREE(CLZE T,
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14.

15.

16.

17.

D RSV OCERDERFERZTTRE I D(CIE. FIE 7 (CR> TRUEFZEDRLET,

IRTD RSy OISO 25, BMZBELRNS MYy IV IRLANIL I U=
J. I7—%=RHELEY,

MEDNW ZVIINTEES, LA —HEEZRWTHRIEDI 7 IVEFEICS T 77 TEEY,
(A) ﬂ w=Svw L. Render #FvTUET,

(B) LA —-UTIT7AIUEENBEDT 7L - TA—-I Y MEERUET,
A= 3> : Wav stereo, AAC stereo, Wav All Isos

EO EEARYRCEFEREEEZRELDIETY, JOZTU hOREF(CEDENDZ E(EFHD
FEA. MixPre (FHRATZONMDD (CEHDULVLEZBEIH(C1TTO TINET.




Intro

MixPre-3M ZHEWN LIFWWEREH DN ESTIVNET, ELIA—FT o A CBEREFDOITOF T &
A—H—T9., BLETHADEIDZZTF—A (RDEFEAEN T2 -7 THD) [TV
MNF. IEECOINO R TAFULRTWIIINF NSV IA—FT AL DT —-DFLWLWRI S —R
ERBTINA R=ZEESEE U

ZOEIRBEENS, YOO RIAUSTA THREUZWECED =2 —>22v>, 22H— S2H-Y
2O SA S —FRDZRARHM E UTHL (& MixPre-3M Z27H 1> LE U, BER. FIBIOTILF
NS w OURER. S T)T A4 -2 RUBRICEWN T, MixPre-3M (FRF—Z ET, XIZAT, DL
([FEIRC. mEDOY—ILERDFET,

COEERFY ME. B OEBRAR—IITILL O—4 —THE>eHitteAVWTERUE U, PR
[ClE. ZTOMWIFRIVIR - JNTA—T A, fELNDPTE, ZTUTCTINHSDOEE(ICE> THRRED
BLEESNRBE EHIRTEONITHZORVMEREEHEIT@mE%R MixPre-3M (CRERUE>THESEN
(F=N\TY,

MixPre-3M (&, ZHMECLBE L, SHXSFTRRERREZRBINHODOIRICLDEREGTSNTNE
ED

o 12-Fv R -TILFRSYILI—F—. 96kHz/24bit

o BIR/JAXDINAITUZ>TD 3 EIFAD

® 5-in,2-outUSB O>E1—4HA—-F4AA>HF—-T1T—X
MixPre-3M (C(d. T2 -3 v > (CARS < DHEENERENTLET,

cNSwo - LAvU>D

Fd—I\—FE>D

INTFA> /T

Fa1-—RA>b

NSwo - o> >
IUNN\—=T¢ETA—-H)L - T7—DI TP
X bt~OJ—A

TITOZR— b

MixPre-3M (&. Protools, Logic, Cubase, Reaper DKL 572 DAW EMfe K S tEeE U TEIMELE T,
UL, BORHMEUTZ/I\— RO T TICKD. —f&fR2 0> E1—IR—XDZ X FT L TH D MNERRFM
HNEBRTITEZEED LR S -2 v U (3EMHECERIDCENTEFI . S-S v 2.
VO S5A A — (SEEIRE. SRARIERADR—FTILY—)LZFERLT. WDTEEZTETIX
EL—>3>FHCEMEIILFLAVT—(CRDBDZENTEET,

MixPre-3M (&. 3 DD XLR ATIWSDA—FT 4 F# - V—R%&E—E(C 3 FSYIETRFCEFEEZTIDC
ENTEEXT, EUWTURTEETEILSCA MO —LtEE. LIO—FT+4 IR CFvSO5—
BEANMRDCEDTETRIN—TETA—HILIS— - TTTU MEBEHRBEINTE D, F(ES5L
WA —TREZEBLULTNET., JA—HIILITF— - TITTU NI, BRETEHEFBIERES
DHDITA—HIVCRBDHREHLT EQ &> T LS a>DESHET, >>H— /Y0545 —
[CIEAZTNHDDET,
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EE53A. MixPre-3M OEREICIERRES DEFBAN. WS DODDELHEEZREITDE -

RS IL AV —EA—I\—FETHEEICLKDTILF LAV —NIEHE/ERTEET,
INBIRIR T Y IILDSA TN T A X RADZFI 0L a—-F+4 >,
RILFFv o)\ F> T - RSV IDBE,

SATAR S, DY — bk v Aty 3>rREDUER.

DAW H® 5in/2out DERALUSB A—F 4 A1 >~F—T1—X

MixPre-3M DERY — R (I EIF YA THSBARDIOTERABRICESSRIZHETIRBELET.
HE=RIEM, UFIOAACATEEM. AT 3>0 AC 7 TH—(CKBEEBEMHEBHTIEERODO T, L\ D
TH., ECTHB. BICHRIENA—FT 1 AZEDIRWZUVEFIC MixPre-3M ZEIFIBWZEITE D,

BEERDA—T 1 AREEFEN MixPre-3M (CKD TKDEBNIRD I EZBELFUICFEO>THDET,
MixPre-3M ZHIFIFWZIZEWeBEHROHBEZBENEWEREITB EIFECODNULIBVNEIDT,
support@sounddevice.com £ TIIIBWIEEITBDEENTT,

10


mailto:support@sounddevice.com

Powering

Flexible Powering Options

MixPre6 DIRETEEPET. KA FETHEIFRFT TV - 3> EARE CERIDIEN TETIRET
HDCEMIEBICEETHDERUF UL, INZRRITDHIC. LWDHDERY —RZERL
TWEEITBARELZ D TVET ., BRY - RZBEIRTIHEUTUTHHDET,

o 4AXRDE=RT)LH), F(ENMHFEESBEESLRZ 4-AA\WFU—-X LW R

o SADE=RT)LH, F(ENMHFEEESBEEELRZ 8-AANWFU—-X LW R

o 1{Ezx7z(E 2 @d Sony 47 L-mount \wF—Z&KELZ L-mount /\wFU—XLw R

® USB-CXUSB-C&—JJLT. USB-CY4 v haE#EFDIOE1—IhEO Y NHACTSI TS
—h\5#E

® USB-AXfUSB-C&—TJJLT. USB-AV4& Y hEEFDIE1—IMEO Y NHACTSI TS
—h\5#E

o (EmDT1I7ILUSB-AX USB-CH—TJJLT, USB-AV4Ty hafFDI>E1—-onEI &
> hRACTITI—n5HaE
® AT 32mDMX-PSUT. Ot b AC YL Y bh5 MixPre-3M @ USB-C ([CHEE
Info:  HWm(C)\wFU—EFEFNHEEA,
MixPre-3M OEIRR (v F(d. ZERIEDA L(CAIELTWET .

Power Switch

11
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INYVFU—A > —SHTHREZERIDICIE:
1. = #29vyTLET.
2. UZXMOHICHD. Power ®HYVSULET,

Power
"1 Back

Battery Type
NiMH

3. ALY RICERAENTWLWBR/N\YTF Y-S THZEIRUET,
A7 3>(&. NiMH, Alkaline, L-Mount T49,

12



Panels

Front Panel

Power S5 b, LO—45—DrS>XR—AERS > 23— by MERXY— (%) RI>,

IV T Frx)L /T - USJ LED. Py FEE

Recorder Transport Controls

Power Light

Channel Knobs Lco
Channel Knob Ring LEDs

20> MRILOF v 2RIV - JTE 2 DORENRSHDET,
LR SV ORAIGERENE RSV IDLANIIL =T D,
JIJEBUT, FyoRI)LVEREIICTIOTCRATDENTEET,

Left Side Panel

Fr>

USB ##t. XLR A 1,2, 3.5mm ®D 2ch A—F« AN, /IND—XAVvF

USB-A Port USB-C Port Power Switch

XLR Inputs 3.5 mm Stereo Output

13
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Right Side Panel

3.5mmAY RIAHAT w2, 3.5mm Mic/Aux AH. XLR AN 3. AW RIA> - T>O—4

3.5 mm Headphone Output 3.5 mm Aux/Mic Input XLR Input

HP Encader

Back Panel

NyFU—=IDT> b SDAEU—H—RROY by "B(FPL2)L2F(1/44>F 20 ALY RRA).
ElERpsLIEEEE >

Battery Mounts

Allen wrench & anti-rotational pin SD Memory Card Slot

14



Screens & Navigation
MixPre-3M (. BAT TERDLTVEREDS Y F/I\RIVART « AT LA ZEH LU TWET, ¥
wF5 4 AT LA (& Home EE. Main Menu EE. Channel BN SRS TLVETD,
F >R)VE@E(CRET DIBEMIE. &R Input Channels DEZSB &),
HAYFFA AT LA, BEENIIBETETBRIRSICLW DI DY FHEENASDET, 1 —H—1>

F—TJI—RELVLTHRULACTWIYFFTA RTLADEABICELD. A>Ty b 7ORTv b L
=T 420 A=FU2TICITEPLEFRNCTITRITZZENTEFXT.

Home Screen

Home BIEE1—(F. FT/\A ADERIKARDY Y FRT -2 (CRRSNDTIAI S - E2—T
¥, COBEAICIIRDIEBRIFTRENE T,

Music lcon Q Icon & Cue Number

Power Status Icon

Song1
Time Counter—oo:oo: 2 1 . 6

Limiter Indicator
L/R Mix Meters

Track Bank Selector
Meter View

Track Labels

Metronome

SD Card lcon ———= 20\107/ Bar 12.1

Remaining Time Status Bar Punch Indicator

15
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BRXT—IZXFAI>

Za1—>vo -7

Home BIEICZ®dD77 - A2 (CFwF LT, Music Control
A Za1—(CT7OTCATEET,

WEDTR—LA

REOZ1—2v o - JOZT 0 hOZRINTRRENET.

AT —

REDY > IAMIEZ. hh:mm:ss:tenths THRR. INT
MDY >4 00:00:00:0.0M 55— ~ULET, Home EIH
TZDE(CHwTF LT, Music Control XZa1—I(C77 0t
ACTEFT,

BEDF1—F>/\—%, Q01, Q02.. LERLET, *
1-—RAY NEBRIDE, BEICTIADI— B3
TENTEBDOT, 8. I—5R, BEATERIRAC
ENTEET,

EIERC Q7> &SFw T UT. Q-Points X —1—%F
<EQURRNDOCATSIUICTIOTCATEET,

s - BAEDICHYVITRE FiLhwFa—RA> hZEE
MTEET, X-_a1—@EmE+1—mR> bE. Play In,
Record In, Record Out, Stop ([CHIEATEET,

(USB #x8)

USB BRY — X (ZRYF.

(USB &)

USB BIRY — MR\, IBEATFAYD. USB-A /R— hOVER
e 48V T7 A A 2 DDF v 2 RILDAHFIAT,

(Batt) #*&

BNy U—, 5—SH1/4 £ CEERE5/ w5 U—
RIS,

H

(Batt 7Rs20E)

Ny FU—BKENBDEFRA, I<ICN\NyTU -z

4
4%0

Menu 71>

Menu BIEIC PRI DIEHICIYVIUET,

Meter E1—

12 hSYTERT LA mix BDA—F—FKR, A—5—
ZEOBEVRY ARG, EDORSYINFv 2RIV T
([CL>TO> bO—-ILENTVBINERLET,

IKE L (Left) X —F—(CH VT LT, Record BT A Za1—
ZHZE, LAR T ARCTIENLK T7ITATEET,

AYFICKD ISV - NN ODHE, SHME. Track
Bank Selecter OE%SHE,

RATF—HRX + )\—=

BFYVFICKDRT—IRERNT A DILRRENET,
Song AF—4X : WEDOD/N—IE. /\>F&EX MO
J—=I LAHUITRF—HR, SD 73— RDF%ES
fi( idle 7 recording BF)
| SEpfelicEA]

16




Main Menu Screen

Menu EIE(E. [FEAEDHEERE. BIRSNIHEE. Y N7y ITHHDFET,

Menu EE(CABICIE :

> Home EET . =AYV ITUET,

3DM Menu BEAE1—HAHDFET., INSOE1—(F. Ry bh7rO> ® 00 ChoTERR
=NFEI, INEYYVIUT, 3DDOMenuBEEHE 1—%2BXDd3TENTEET,

LR Stereo

0

Presets

Project

Outputs

ft O

LR Stereo LR Stereo

ft O

Metronome System

Record SD Card

Menu RDZNZENDAT S I>=IvITFdE BIAXAZ1—HRRESNFET.

N=S | BTJAZa— | 34

1 Presets SD H— REAIBAEY -, I -KEDC—TEVI-)L,. TJ7IOKU—
FIAINCERBDEREDULY K,

1 Project FRER. BIFETO0> 20 hOA—T > CHIBR.

1 Inputs 3.5mm Aux/Mic AJIFEDERE,

1 Outpus main L/R & X1/X2 RFLARDRADIL—F« >0 451 ETE,

2 Reverb D )\—T DETE,

2 Metronome | X kO —ADEE.

2 Record LR SwWORS 1>, ACC TUANR— MRBDNE.

2 SD Card BASINTWND SD H— RDIFHR. TA—Nwv b H— RZEZE(CTDHEE,

3 USB Drive USB H A RSATDERDER. RSATDITA—T WY K,

3 System J7AI)VERR. b—2A4E85. U=Zwv4—, H{J. LCD/LED EBE. J7—ADT
7Yy ITF— K~ BEDOD/N—-3>,

3 Power ERALTWLS/\wFU— (Alkaline, NiMH, L-Mount) fEFEDEE. & CDETE
T. Home BIED/NT—XF—HF A7 1> T/I\wFU—KENEULFRRESN
ESER
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User's Guide

HIAZ1—HB5A1> MenuNRBICIE:
> I BACK =AYV IUZET,

A4 > Menu H5 Home EHEICEIERSI(CIE :

> M BYIYIUET,

Music Control Menu

Music Control X—1 —/H5 Cue List. Solo/Mute BIE., X O/ —A
SO RERAKNI—, ([CT7OTCRTEELT,

SHHRBRRICDVWTIE, BIRDREESEIIZE0N,
Music Control X =1 —I[C 7RI BICIE:
> Home BEODEL(CHD n AV TUTLESU,

Cue List Solo/Mute

L JOZxz ok - TJ0O
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Input Channels

A>Ty bF v oRILE. FEESNEDMOF v RILESYVIRESNED T BEIICA—FTAA - V—
AMIBEND/INATI, MixPre-3M Tld. DAW OHD [ cSwo | EEICEB>TWWERZWTHE
LEBA. &E1>TY hFv 2 RILICEBSNSY —X(E. XLR @ mic/line. 3.5mm Aux mic/line. 1
SEI—INSDOUSBFvr )L 1-2 hSERAIGEIRTEFY,

MixPre-3M O=FH—HH. AE~NTT. A O/ —LADTUYVOEEREIRTBDCENTEZXFI, A
—)\—ATHEEIC KD, MixPre-3M DIRZAJRER MV OIT 12 FSYIETT, —ELEETES
BRANSYIOEIE3 FSYIETTT,

IRTCDA>TY bFrORILDFEG. EF v RIVBEORTHRET DI ENTEFET.

Setting the Mode
Fv ORIIEHEICTICRATSICE :
> FOBRUEWFv 2 RILDOF v ) - JITZRUET,

Linking
OfF

BF v ORIVEEICE 2 DOFRERAR—INHDFET ., R—JAIERF>RFY b - PAO2 TR Ry
N T7AO2CHYFUIR—ZZYPBERDIENTEFY .

BIAZ1— 15ER5E
Solo & Mute Using Solo/Mute
Arm Arming a Track
Input Setting Input Source
Monitor Enabling Monitoring
Gain Setting the Gain
Pan Understanding Pan
Reverb & Air Using Reverb & Rendering a Vocal Air Effect
Low Cut Setting the Low Cut Filter
Phase Toggling Phase Inversion
Linking Stereo Track Linking

MixPre-3M (. 3 DD T4 ZHILF v > RIL J TEINDELZLD RSV (&K 12) 23 D=8, track4
LABGDIRTEIC T ORI D=IC(E. Bank selector #ERULEYT, %k Track Bank Selector #&
BBEE0N,
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Track Names

BRSYOR—ARJ BEITIFvRIBENSHEETDCENTEET. FIXE TITAIL MR-
D Trackl Z Drums (C. Track2 Z Keybord (C. Track3 %Z Lead Vocal (C. EWLWDKDI(T,

Trackl DEBIZERET BICIS :

1. Fv>RIL1D ) I=BULET,

2. FyYoRIBEEOELBIEDESIYVITIUET.

3. Trackl ®FFLWLWEBIZ AN LT, OKZAYITUET,
RESNTER—AIZ. ZORSYIOTF v R)VEEO MY FICR RSN, BEFRSSNTWNDD
7AILDASFT—1Z1F T <. Render > Wav All ISOs Z#{ERI IFDL >HF—=NJ= ISO T
7AIVCBIARTY Renxd.,

Setting Input Source

Input RY>T. ZDORSYINA—FT A AANY - EBIRTEET,

ANV =R EF ¥ ORILDMAEDEZBRICGRETEDDT, A—FTa4A4 - V-AEERD NSV

CHREULEVWKCT—JILEZEZUBXDINERGDFEFA. ANY—X(C. MixPre-3M OH S

(Bouncing 8ZZ£M). X O/ —LDTUvIE (Metronome BZZHR) 27512952 EET
=FEI, e COBERMS I 7 A LAERD On/Off BIERETCEET,
A2 MAIV—=FT4 20T BICIE:

1. FyRILEEICAD., InputZ2FvITUET, ROTZTIVEGFD KX SR —F« I BEEHE
RENFEY,

Track 1

2. bSYIDY—-R%Z1D, BIRULEY. bSYITILRSATANY—-RZ 1 DREIFHETETET,

3. WESUTI7Z7 > ALEREZBICUET, [Phantom] (& 48V EED on/off T, HLI
ST —oO0TAHERSNTUONE. T7 29 L8AICULTLIES0N,

Info:  Phantom AT 3> (@ERENEA—FT oA - Y—XICED TEFERRESNFTE A,
4. AbOJ—LDOYUvOEEFE UGS, [Click] ZBMICUET ., FERDT—45% DAW
(LA >R— MU THIICA—IN—SFETITIFBEEFTY, FENEX RO/ —LZFAHLT
DAW OF > RERFEITDTET. MixPre LO—F 4 > T ERECZEBRRDTENTEFET,

Tip: RSYOMAF LAV OENTND E Click AT 3> (3BT,
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Enabling Monitoring

- 9 *%% (at EEE':F'(CE’I'j ’r/j‘J I\E’?:BFEﬁ(L_&D‘_C%i@'O ITICHRE SN SYVD

EZH—ZBEMCTBICE:

> FYRJLEM@EICAD., Monitor 29YTUEYT, EZH-O0OnDESRYEIAL O SETESR

=NZE9d,
1: Track 1

Setting the Gain

FrRIVARC, BUL-THa4> (TUITT-HF-54>) ZRETETEIT., DT EFFvxR
IWDER DSV IDESLANIILVERELET. HIZE ISO SV ILANL,

GALI2E BRENZA>TY b - FATCLKDERRDZFT,

- Mic : 6dB
- Line : -20dB
- Aux Mic : 10dB
- Aux Line : -10dB
- Aux InMic : 10dB
- USB : -20dB

Using Solo/Mute

SRR SR

76dB
30dB
40dB
20dB
50dB
30dB

MixPre-3M (C(E. SV OD=a1— .

VORI B3EHICVW DO DERD S ENRDDET,

B RSYIDF v R)LEET, Mute 29V T U TERENE NSV OZZ1— b TEFT, =
A—hESNERSYIDESEIVIREENICESNFEEA. Sa—bend &, JITREBEIICH
D LED U INWKRUTUET . ARFICERDO NSV IEZ1—NMNITDIENTEET.

Z2RSYIDFvORIVEET, Solo Y ITUCGERENE NSV (TTUTJT—R, JUT
Jx0K) OF%EAY RIAZTEZA—T=FY, VOICRKRO>TWB cSwvo(E, LED U>OH

ALZCRITUET,
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BHDO ISV OZI(E<VYO/ 21— hIBICE Solo/Mute BEANMEFNTY ., £12 SV oDV
O&=Za—baloEENSEE BRI ENTEET.

Info: *>3—bAv MNRIYICTZHYA> LT Solo/Mute BIEIC 7O TEET,

Solo/Mute EHEA'SYOFEFZ1— M BICE :
1. Jl&5yFUE. Music Control BENERENET.
2. Solo/Mute #9vwFUZEY., Solo/Mute BIEINEFRESNET .

Solo ﬂ- Mute

3. ROWITNHDERIEEITLET,

> SoloMMute DEESHMZEFYT L, FED SV IZERLET. VOO EF v >RIL
FAL BT, Za—bSNERSYIERFRBTERRSNE T,

> HPI>O—A%BIEULTERED NSV OEI\ASA NMREE (FREDH#) (CLTHS. Solo
Mute 9w FUZEY,

4. M EHYILT. BEELRTUEY.

Arming a Track

Home BEIDA—Y—E1—D Sy IBEST, 7—LA (BEB) NSV IRFKRETERRSN
ESC I

cSvD& 7—L/7—LfEE 935C3:

> FrIR)LEENS Arm ESvYTUT. hSw D Rec 7—LAD On/Off ZZHELTLEEN,

Understanding Pan

Pan ##{FC. LRRAFLAZYIRX(CHUTDRSYIDA—FT A4 AD L & R DAIEHNREDET,

Pan L>> (&, LI6(LEBX)MS C (B>45—) NS R16(REKX) M 33/RS>3>TY,
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Using Reverb

U=T @ LREYITADHD RS IILCENEIFIUN-THRZEZ DN ERELEFT. VIR
RIFCHRNS D A4 DEESNIE NSV IICHREHDEE A,

82 DFEENE bV INUN-THRZEL >HF—FB(CIE NI ABREZFIAL T IZS0N,

Info: 96kHz Y >T)LL— hTEUN=T(HMERATETEFEA.

UN—T%RETBICIE:

> FvYXR)LEEMNS. Reverb Z9vYITUTI>O—ATHELTLSIESL, FAREH (L. Off,
-50dB H'5 0dB =T 1dBXFWV IS T9,

AT Tao4. TUFTA LAREDRIRDIIN-T - FvSOF—ZBIRTETET,
UN—T&/ETSICIE:

1. = aoyTLET.

2. HIAZ31—(ER—2ZUT, Reverb &Y ITUFET,

3. ROFEZSFYILT, BZEELTIREN,

tyF1>0 ATS3>
Reverb Type Off, Plate, Hall, Room
Reverb Decay 0.1-50#%
Reverb Pre-Delay 0 -40 ms
Reverb HF Damp Off, 0 - 20

Rendering a Vocal Air Effect

U—RIJA—HILICAr II O ba@EAITDE SYTADRATIA —HILNEIELEFRT ., U
KO T A —HILICRERSEDIIESNE T

TA—=FI-ITTE LR IV IRADRD LSV ICENRIFTIN-THREE5EZ DN ERELF T, #3
& (L. Off, 1% ~ 100% T3 . IVIRLEFICHRNAHD., L DFEENZ SV IICRHRE
HOFEA.

BaDFESNERSYINArIIT O ML A —T3(Cd WO RigEgE=FIBL TS0,
Info: Airl3—EIC1DDOMSYOIGERASINET, NSV IICAir = @BALELDIC, Fv>
IVEIE T Air NI LA (Z122> TEX IRV, I TITEHSINTWDIMD hSw o0 Air

ZHUTLIESWN, BEOTA—DILS Y DI Air 28R T BIC(F. /D> XikEE
FMRALTLZE0,

Setting the Low Cut Filter

NAOINRUZT JA XD, D42 R AXTRET DR ERMEBRD ZRET DeHICO—HY
bzERL TS0,
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Low Cut /RF>m5, On/Off LO—HY RIqIILY—&EEZETEEHT, &FEIE Off, 40~160Hz D
40Hz RV I TY,

Toggling Phase Inversion
AAERER (F/z(EIRMERER) (&, BED CERESNE/I\S X —T)L. REAEICEVWTERESNT
2DOXA0OTA> (RSAFY ROA—I\—AY RRE), BREDSTFIL - Fr>ZL—>3>
ZBE<TZHICAVSNET,
Phase % (&. {ItBR#D On/Off TI.
Fv oRIWDMEERET BICIE :

>  Fv>x)LEEMNS Phase #2Fv T UET,

Stereo Track Linking
ABDYV=ZANZAFLADBE. 2 DDRT « RSV OO E 1 DD T TEAEDRTDLAN)LZE T
RO—ILTETEFTYI, F—IR—RPOPXAFLA - XM ITDEDIRBAFT LAYV - ZFAT DIHE.
MixPre-3M M1 > Fw ks 1-2, 3-4, R E (TR L. R ERDBRYVIDOF v > )LEEOD Linking menu
TUOULTLKIEEW, UZOICEKDT, FHEESD /I THADLN)LZ IS RMO—ILTEET,

ROPITE, FroRIL1 272U TITDIFIEZBITLUET .

Ch1,2 2U>093IClE:

1. Fy>RI)VBEEICADEDHICCh-1 D/ T=ZBUET,

2. LinkingZZ5vFUET,

3. RFLAYV-XAIC 1-2 ZFRULFT,

CNThrSYT1E20MADLANIE Ch-1 JTTI> SO—ILTEET,

Configuring Aux in Mode

Aux/Mic In ORI I—DEFEZT BICIS :

1. = m5yTUET.

2. Inputs > Aux In Mode &9V FUET,

3. RDATZa>hs51DZBRUET.

- Mic Aux/Mic In (C Mic BficnN3d3&EETDAT>3>TI., MixPre-3M (&
PiP(Plug-in-Power) D/ \A 7 RBEZMIEUE T,
- Line Aux/MicIn ([C. AN — KT A>2DOA\Y RO A >HNIREDT7>INS X 2ch T

N =ANMEREINDEETDATSI>CTY,

- Internal Mic ANYV—-XREUTAHABNYAIZFERIDEETDATSa>TY,. fXE #HI7A
FTATEST c ATSYFEULTITREPOLEREFURWES. X204 >0 F
TR TEEICZEZODSRVLWOTHSNZE. JO> ML (Fv>oxIL)T 8
D) ([CABMESNBIYAOZFBITDZENTEET,

- Off AT(E. Aux/Mic input DA—F 1 AN=Z1—hENET.
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Track Bank Selector

T4ZHILI)T (4D) KDELLDRSYYT (12tracks) #H'H2DDT. by o - )\>T - LD
S—EENHDFT, TNEF. XA—F—Ea1—DORTHVWHET RSN, O> bO-JLUZWSS YD
DI —T &R DIHICHALSNET,

ROFITE. bSwvo 10-12 A JO> N FRILIEHDFr >V - JTTO> bO—-Lansdc s
ZRUTWVWET,

ﬂ ArtNotTech

05:10 P

cSv D - NOORMBRBICE. DEFONWITNHZEELET :

> TNETN4ADITDDOLSWYY (1-3, 4 -6, 7-9, 10-12) ZUBXBEHICA—F—%=FIVTUFE
9, HIZ(E. BUVEEN 10-12 (CHDEE(C track 10-12 &2/ JTO> bO—ILTEEFI, A
—S—&AYVITUTHVWHEN 1-3 (CBELIEET D E. SE track 1-3 27> bO—
JLTEZEY, Track 4-6 £#1>> hO—ILIBICEED 1EYVYIULET,

hSw T - N ORIENDD & FizlSERESNZ/\>onshT )/ JZzEUIEELTE. MATICR K7
ENET T —EISEURVRD. T DABENRBEDOLANILRERICRRENFEA. UBTDMESE
IDE TAAREIBEED(C/ JOEERAIE & EEUFET,

Info: ~Sw O I\ ORNBX 2%, ) JOREAMBEN DD T —4 —fEETB3D TLVRLRES,
JIDLED WAL >2ETERUET, / IJMEE T T —5F —ENTS DA THEIT
bia_o

FroR)L - JTREADI T —F—EELE. HHEIICA M PENTVWR I -5 —ERAL>ZET
Home EIE (HhFv>=/LEE) OLEBICRRENET, JIZRBELTHADEN—HLIZESS
T, BFOEHERBICEDDET.

T —5—LNILERTRDH
ZOBITE. TaZHILT -4 —DfEN -18dB T. bSWT 9 DFv>RIL - J T =55 EERS M

([SHRRBULRINERSRNWC EZRENRUET .. BRIICA RN ZENTVSE. ZZ7T@E -15dB (TE
9L SYITRINILGABTEDLSICRDET,

- dB [ JJ 9:-15dB —
00:00:000 | Qo1| = 00:00:000 | Qu1| =

Info:  BREICRA RV ENIT—F—BERN7AOY (AL228) ZRRSEDEHIC(E.
FrRI - JTZIKDINFRLTIZSV, BRIRRSNDZET, EE5D
MENT T -5 —ZHEITINESHhZHITEET.
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MixPre-3M
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Outputs

MixPre-3M [C(d. AFL7 3.5mm 77O Iy k [P2INS2X] B’HDEFET.

L/RAFLALINZEDSICIK :

1. = &YvIUEY,

2. Outputs Z9vTUFET,
3. 3.5mm output (CEZXB/ZHIC. Stereo Out #FvITUFET,
L/R HDDA—=FaA - V=& LR TVIR (RFLANE/SIL) FIFTRI ANV RIAH

HY—-REAUA=F A AMES (RFLANE/SIV) ZEIDEHTRIZENTEFT, INEFEH>S
U— Ay RIAZHDEUTHHATETERTT.

Stereo Out
"1 Back

Mix LR Mono

HP LR Mono

Adjusting Output Level
HBHTA > ORE(E. FSORZIvEY—, HMEB=FH—, PA I2E. BATERINTEEMAXDES
HEEPIRLANIVCTBEHICEETY, EHFTaL A& TOYIS3>TETH - ARL—45—(C
A—F A ABRKRDEEIC, IASHRGFEA—FT « ADOEPLEZENDE DI EHICHLNSNET,
HHhFAEFA LA ZRAETBICE:
1. = =YYITUET.
2. St Outputs #5wv T UFET,

3. St Out Gain Z#IRUFT,
A4 > OFREEHE (L -40dB ~ +20 TY.

Outpu Muting
MixPre-3M T. 3.5mm stereo output #=1— MCTEFET,
HHhze=a1—-hr93ICF:
1. = &2YYIUET.
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2. Outputs #5v T UZET,

3. St Out Mute Z#z5wvFUZFEY,
ZhiE. Mute @ On/Off ZI& X F 9.

Headphone Out and Presets

MixPre-3M DA —F 4 ABWRENIANY RIA> - FoTIUI7AT(E. I\AI)IND—TIK_J A X712 D
T. MixPre-3M DEURD A —F 4 AZIEH(CAY RITA D POIRIBICEAFRRSEZASA—IBENTE
F9, \VRIA>TSH% (BAEICHD) 3.5mm v v ICEHRLTIEESN,. ANYRIA>
BE/RU1—-AGF ANYRIADSvvVIDBCHBITIA—FTREIBZCENTETET,

Info: Ny RIAZHADT DT (EERBICKRSIRLANILZEN T DEEAN DD EFT . NEURT
SRBOFFEANY RIAVEEU VWD EBEREZLZZIDOTHER F =L\,

Menu BEIEMS. BEODE LICHINANY RIAZDTFAAVICIYFUT ANY RITA> -
n JUtw b (HPPresets) [CFOERTZIENTEFY. OO LT, REER
ENTVWB HP Uy MMi&RRENET,

HP Presets X =1 —TC. =FIFRTULwY NEBIRTEFET,

HP Preset HP Preset

Preset 4

LR Mono

LR Stereo

Edit HP
Preset

Preset 2

Preset 1

A< 3> : LR Stereo, LR Mono, Preset 1-4, Edit HP Preset

HRAILHPTUEY FMEERRTBICIT :

» HP Preset XZ—1—T. User HP Preset MiREZREIZ(TIT D=, Edit HP Preset Z3&iR L
ESCA

Edit HP

"1 Back

Preset 1 Preset 2

Preset 4

Preset 3
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Metering

LEDs and Metering

MixPre-3M (1> v hETI R Y RDLARILEERT DIZHICWL DHDAERSDET,
Fr>xIL s JTDYU>I LED, Fv 2 RILBEEA—4—,. Home BIEOA—4—E1—,

Channel Knob Ring LEDs

Fr>x)- )T -USD LED - & LED U>2J(d. JU—> AL, Ly RICKDFT,
LED U JDRAZE(EF. 4>Ty hOLANLEELTVWEYS.,. JdU—-> = 58D, LyR =
SOFIV-E—F2T, AL>T = UZvH—EeEsFP. Flo Fr>oRL-vOREG F
vIRILDUZYD LED WAL 22T (BAFEC) L. 12— bEneF v > RIVIERUTU
SN

Recorder Transport Controls

Power Light

/

Channel Knob Ring LEDs Touchscreen

>/ LED AL >ZEBT (FOM) ST DdDIE. hSwvo - )\ OMIBZSNEEIC. T+
ZHIL) TDREHRIE ER R ESNTWVWBD I T —F—ER—BUTLWRWC EERUTWET, JT%
AL TCIT Y —EE—HINEAL>ZED LED (EEITULET,

Channel Screen Meter

Fr)VEETE. bSYIR—LADI S FIRLNRILA—T—DRRENET,

1: Track 1 1: Track 1
A amm

A

Linking
OfF

Normal
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Meter View

Home BIEIDA—4—E1—I(C(E. 12 FSYIDOEBEER/\—A—5F—PFRR=N. L/R TVIX
[FKE)N—A—SF—HWRRESNFEIT, XA—F—E1—(CIFrSVT - IN>T - LLOIF—BRRSN.
CNUEIA =S —T)L—TZESHAVWVWHR T, HIX(E. RO”TE. bSwo 10-12 MEIRESNTWL
ia_o

D ArtNotTech

05;10 ; P
A= —DFRICEKRREND FSYVIESHIRSNIESANILE. IL—F 4 >0 RS> XR— MR
BUTEBRAEDDET,

JJ BALLAD
00:00:17.0
L )
N

45 [6/[@8 900112
B 00:21/Bar3.4 &

ROKXE, BHFWECHICRBICENTED ST FRATZ a>w2RrUET,

rSv oSN g3

i BE7—LRBE, SHATA>Ty hNEEZSY—H,

Boh (TR FE 77— LREE. NSV OBEEEZS -0,

% NSwOB&ER,  (EFEURVIREE

JLA ((B1EE) RSWOICA2TY N—ZDTHA 2SN TN, S URRVVREE,
2 NSWOCA 2TV RY—IDBTHA > ENTULR,
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Projects

MixPre-3M MOH T, IPEMZT O T I hEUTEIRONE Y, O T U b EFKREMICE,
SD 71— RD 1 DDI AN DHRICHEIMENTZINRTOA—FT A - TFAINEZFZ 2T - TyT+
SOEUEYS. I—Y—(Cko TAWFESNIZREME T ALY TEREND 2. /\wI7w TP
E—EfETY. JOZT b - TAIIFCEEFRR [Ty 3>] JrLEEFEN. N &5
SNEA—FTaA - T7AIBEDRSYIT, FEEDIALSAZTHBESNDHZ MixPre-3M
AERECT> bO—-IILTDHDT7AILTT,

B2, 1 D=1 -2y - OO MEI—MEINER DAW ERIUL@E, 1-—F-HFRB0E<GE
DDEDTY ., TLA - H=YVILFKETALSA > LEBEI U BEDA—FT 1 A+ b5 W (MixPre
DR TEF v >oRILELUTIRNDND) MMECTUET . BIFEC 00:00:00:0 (hh:mm:ss:tents)H
BRY—KUZET,

Start End

00:00:00 00:01:00 00:02:00 00:03:00 00:04:00

Track 1
Track 2
Track 3 |
Track 4 | |

Track 5 |
Track &
Track 7 |
Track & |
Track 9 | |
Track 10 | |

Track 11
Track 12 ] |

|
Play cursor
I—HY—-@FZ<0TOZT U b 1 MO SD H— RICNDDIZENTEIRZIFTRS, BRZTIO>T

T AT ERLPBERISNDDT, 7ILATWER EEBHOFEITER(CERZRCHETEFRS. &
B. MixPre-3M TE—EIC1DOTOZ TV NI OT« T (TIREFTEET,

IRTOTAT IO - A=FAa4A - T7AILERYT A2 BIRE SV ORINSGA-F, hSv
OFx%—Ah, OO MEXRI—12E) FEBNICHREFSNDDT. FEkRFZ UEND0LEIFSHD
FtA

BEURERPICHKSTILTEBRZEAKRDTE, BRBI DI TEAMOTIOZ T MREICRDFT,
ZUCERNMRONDIERIF CRESN VWA —T 4 A BN EBEROND T EEHDFEEA.

BRZHIRAT D L. MixPre-3M GEBN(CREICERALTLWEIOZ U MeO—RUET,
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Creating Projects
MixPre-3M (&, #FHTOZ U bZ2EH U THRULRLSTSE, record Mena LEBMNICTO>T
I MMERRENE T,
M1 —>vo - 0> H M eERTBICR :
1. = &5vTLET.
2. Project > New &9V ULZEY,

New Project

=1 Back ﬂ
Name Sample Rate
Song1 48K
p— Import

[€3LC Recording

3. ¥t Music Project BIINRRENTES. ROWVWITNOZIRIELET .

> JO1I U MR—L%ZRET D,
> Y2ITILL— hEEBET D,
A< 3> : 44.1kHz, 48kHz, 96kHz

Info: FRITOZT O MERIFFIELVWS>TILL — FEBATLKIZE., CORERTO
ST MMERSNIERICEEITDCENTEFREA.

USBA—F A AA>2F—TT—RXEUT MixPre Z2{ESK, J>E1—4 0S, DAW 7
TJU—23> 10M 07O 0 MPEUS>TILL— b THDI S Lz LT
=V, ZNEoOvoE ATRXE—RBEDEEE/RDET,

4. ¥ Music project Z1ERR I DERNEDS =5, Create ZFV T UET,

Info: 70210 hR—AlF Home BIED L (CRRESNET.

Import Recording

FRIO> O MERES., .wav A—F 4 AT 71)L (12tracks £T) 270> T hCOERELTH
SIR—BRTEEXI. DAW D'STILF RSV IA—FT 4 A%ZA>2R— KUT. MixPre TEEHIVEZRE
TR ENTEFT, HDWNE. SATNTA =T RAICDAW TR LIZ/N\WwF> T - RSV o%E
A >R—BKMUT. MixPre Z/\TJA—I>XPOBEEBEEZFH—HEFNRDIA—ILA>DT2FTINAR
(CFIBTEEY,

Info:  MixPre-3, 6, 10T ® Audio 70> 1 hTiE=N/e.wav J7 )%, Music 70O
IONIAIR—KTBRZEBTEXY,
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FERAT 4T WAV T 7AWV EN—R(CHRTOS T MER :

1.

2.

= zyvTLET.
Project > New > Import recording =45wvJUZE9,
SD i— REDAR—bUIEWIT 7AILEEVET,

> HPI>O—4A%ELT SD H—RD)L— ~NTHD.wav TJ7 AL =EERLUET,
> Audio OO b - TAIASAEBRL., TDOHD.wav T 7ML ZEIRULET .

Opening Projects

REDTOZT U MSROTOZ IO MAUIDEZ D, REDCTOZ T U MMOE-TZHEID
ME(EFHDFEA. MixPre (FIREDOTOZ T U MREZBEBNCREFLTLIMNSTT.

BRI LIz OS> o hERL IS :

1.

2.

= v ILET.

Project > Open Z&5wJUEY., SDH—RLEC, IRTOTOZ T MU RERREN, =
1-Svo)—RFAO> Ij TROIBZENTEET,

HP T>O—4A%=EELTIO>T O MDD 1 DEI\AMSA MAE(CLEY, IT>O—4F%=Fg&S
O>x0 bEREEET.

zDTIOZT U MFEMNEES Home BIANFRRSNE Y. CNTHREXY— M TEFET,

Trashing Projects

AT VEENFH)\A MRD SD H— RZEATDE.TOZT I DU NINREDRLIRDFET,
REFOT«4TRTOZTI MERVNT, AERTOS T MEHIBRI S ENTEET,

JO0>x O haEHIRTBICE:

1.

2.

= =5y TUET.

Project > Trash 5w U%EY,
HIBgg 270> h% 1 DEIRUET .
BIRSNZTO>2 10 bOBIBRZEER T DIeHD OK 245V T UET, BIRanfzO0> o &
BETRINTDI7ILA TRASH JA)LA (CBEISNFET. > E1—4H5 TRASH TJA4)L
BDICTFOTCRAT B EFAETT,

Info:  SD 71— RDZEZHFE=&IENT2HIC. TRASH T AILSFKRDT —FZTE(CHIBRT BI(C
(. SD Card > Empty Trash =R{TULTLIZELN,
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Project History

BESNDTLC. EXRNU-URBDHRCTATAL (VEZI3Y) LEUTRESNET. ZIh5.
HIDIRE T 1IN [T R ] UIZD, BOTFEEN U RS ] ULIZD & BRDEET DU EHARTZD,
BOTA0ZFTEPKYURDIBIENTEFT, EXMNI-UXMIFERIRICTRRL. FEFLLL
-5+« >0 by T ICRRLUET,

EXRNU—URRNT, Bi/#OLI—F1>JICIDBXBIC(E:

1. Home BEODOA_L® ﬂ =AYV ITUET,
2. History #9vU%xd., EXARJ—UIMERRESNET,

SONG1 r
<1 Back ﬁ

001-050418-084910 *
002-050418-084829

Hp i Vo

3. HP I>O—-A4A%ZBBIELTURMDFDOIT 7))L %% 1 DBIRULEY . BIEOL O—F 0 >ThT7
AFIURIOI—D () NI 7AIAZ—LDRICRRINET,

Knah

Info: VEZ3a>OI7AIIR—AFRERTTOBMERLZTICLTVWET, HIXE 2018
F 3R 12HD 2:22PM(14:22)(C88E 5% T UIE I 71 )LIE 001-031218-142200 &
1R0FEY,

AROSYFHSREDITOSII MEVURI—NTBICIE:
> EXRNJU—-UXRHS, —FFICRZO-J/LU. Restart Song Z&ERULET,
Info: CNETOZTIOMNSIRTDA—FT 1 AZIUT L. BEICRIZEEFTEEE

Ao UDU. A=Fa A - T7AILENBHRDEIBREND @D ERA. NS
FTOZT O - IANAFCEODTED, DA EI—INBT7IEATEEY,

Project Folder Structure

1D207OZT 0 - AN CEDEDT7AILNEENZET,
JOZI U hOBEESNEA—FT 1A WAV T7A(I)Lb. bSyOTRIESNEZ, F@EA—/(—
HITENZEDIE Z2TILDE) TAZWI WAV T7)LTT,

Info: J7A)ILR—AGHFESTTOBMERBZTCLUTVEYT, fIXE. 2018 & 3 A 23
H 1:33PM(13:33)(C#&&E T L2 T 71 )L(F 001-032318-133300 £132DFT,

1DDOL>A—TAIAF. IRTOL>A—nNkeA—FaA - T7AI)LE. 1 DD
SESSION.XML J7 )L (ZFO>x 0 FRICEGFSNTWBA YT > 0EA—FT oA - T7AIL
OBEIRIEZEET D) "ESENEJY.

JOZxOb - JANIDASF VA E1—ITHRREITDIZENTEET,
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Sharing Projects

ST 77U - TJOST o NI SEICOCE1I—INEREL, T, 1245 —3RY NTHRIICT7YS
O—RIBSENTEFET,

JO2 10 b zEHEBIBCENDIDNDIEENSHDET,

JOzz ok JA)ISFDIE—: MixPre-3M 1—H—RAETTCOFELICELET, SD H—R
MO0 MAREO0—RIBITENTSE, JO> T MeELRRG TEET,

Wav h* AAC AL AT 7AILICL > — 1 BRAWIS RADIN—(CRERSVIREEITOIE
UET.

Info: AAC T7AIUE .mp3 A—=F 1A - T7AILDELIBREDT, BLEY bL— KT
HNEAACDEOINRVRBZIAF CEFT.

IRTDO RSy (ISOs EUTEHRESNL) Z2E€ ) ITIAZY D - TrAI)LELTL S~ DAW
(CAZIR=BLTTOY IS I AEZRITDDICELET,

JosxobheL>H—-93ICE:

1.

2.

3.

ﬂ =AYV ITUETD,
Render #59wv S UZE9,

Render
*1 Back

Wav Stereo | AAC Stereo

Wav All Isos

LA —#DT 7R ZRELE T,

Wav Stereo: FEEHED 2ch XF LA wav J7AILIC LR SV OREUTILEIA LICL ST —U
*x9. L>AUTdhD, hSvILRIL, N> Za—b UN-T, I7-IJx0DT
NTOFEIIRAFT LA wav TJ7MIVICKRRESNET .

AAC Stereo: EfacN/z 2ch DXF LA AAC T 7A1IJUIC LR WO R =Y T7ILEA AL 25
—UZE9. AACT71ILIE WAV T7A)LELRTHRDINENHAXIRDT, A>T —FY KT
HEITDIOCHEUET, L>AHU>ThD, Sy ILNL, I, Ta—k UN=T, IT7
—TITIJx0 hDOIRTORAEELAAC TJ7MILICKRENET,

Info: AACFHDEYW cL— M. XA> menu @ Record > AAC Quality @. 32, 64,128,
192, 256 kbps WSBIRTEET, HENKEZTVEE, RENRLRRADET,

Wav All Isos: IRTDOFZAYVL—b - hSVOZZENENE) ITAZYD - wav T7-1ILAD
TILIALNIL A —UFET, DAW [CIRTDO RSV IEAZR— NI BDCEULET. IART
DI 7AIL% DAW DA LSA>OEORSIIVICRSYIITREITT. FSVIBDEIA =
SO TEE(CHILE T,
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MixPre-3M
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Recording and Playback

MixPre-3M (&, SD 77— K (SD, SDHC, SDXC) (C 96kHz, 24-bit Tqw&E 12 A—F 4 A RSV IFET
BREIDIENTEFT,

MixPre-3M %Z USB A—F 4 A1 >AF—TJ 1 —AEUVUTERUTWBIETHE SD h— RICEFEFI B E
NTEEI., OE2—-INBD USB A—F+ AHXH%ZE. MixPre (CIEHGSNEIA IS A AN
V—RXEZVIRURHBHEITDCENTEFET,

Ld—-5F4>0& USB A—F 4 AR KNI —Z>20ZERF(ICITIRENICEID. OE2 RS (ICHU

TON\yO7yTLI-F—EUT MixPre-3M ZFIAI2LETEFY, F(C. O>Ea—F 1A
DHCFADICEVRITDHDIEEIRA R bOFE(CRETTY .

Formatting SD Cards & USB Thumbdrives

EREMZRF SRS - BEDSHIC, SDHI— RET MixPre-3M TI A4 —X v b TLVRIFNIERR
DEEA.

Info: ATAT7HITA—XYRNITDBEZDHRCIRTOT—INEZIDIED., TA—<W KT
BHICWHEBIRT—SF%&T )\ IOT7v L TLIEE0,

MixPre-3M (C(&. BED/I\TA—X > XAzt 9 Bz (CHRE{L =MN/z Sound Devices 1t 75> RdD
SD H— RZHMEAESNDC EEBIBENOWVNEUE T, HERSINDIAST 1 T7HBFCRVNVES. B
D EBEFRTEBDRIET (SanDisk 7 Delkin) M X5+ 77T, class 10 speed &z M ENA LD
BONLEUWTI ., USBHARSATICEALT. BEDEREMEDIZSH(C Sound Devices DERFEAT
-« 7(Approved Media) OFERZR<HEREUET,

SD H—RZIA—TY NTBICITE:

1. BE/\RILICAETDEAOICSD h—RZEEALUET,

2. = ZIVIUFEY.

3. SD Card > Edit > Format &9vUZE,

4, H—REIA—TV NITIEREEHRRNTES, OKESFYTUFET,

BFEN 32GB LIFTD SD H— RF FAT32 J7AILZ AT LTIA—XY heNFT, TNLDKRER
BHEDSD H—RIFexFAT 7 AL AT ATIA =Y benZFE T,

Transport Controls

MixPre-3M @ b > 2ZR— O bO—)LIE —#&8972 DAW T bS5 > XR— bl 930D EE O
BETY . HIX(E. DAW Tl TLA/)\wD - H—V)L (—RRMIICHS 1 > D BIPDIRIEDRT 51 L
SA> FOMNBRKECEEULUET.) #0> bO—JILUET., BEORSS 3> (E R—ABEO L
THAHAMI s HIA—(CEKODTERREINZET,

INRTOIOZ T ~E 00:00:00.0 M5RF—KULET,
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27>9>3> | dA>bO-=)b | 5
HFEh. RYUIIR<KBRBUET,
Record
RECRAG>ZIBT & HA LS > LEDREDRSS 3 o SHEEETF
FTHIRUET. FLEFREITR<BERTHISEREICADIENT
ZTFI, BEF T —LENEFroRILEITTY,
BERICORIZHTEEILELET, BERICRIZIRIT EEEL
Stop F9,
{EIERIC STOP R Z T & VU IDERIICT LA\ - =Y
ILHRDZET,
{EIERIC, HP T>O—4A&BURASEIT &, 1/10 BT DEEAY R
ZENNT ZENTEET,
B&Eh, RYUITERETEHRUED,
Play / Pause
B9 & REMENSBEZRIELEYT., BERICINBEND &,
ZDMBETR=ZIREE(CIRDFET,
EUBDORETHEINTE., AIERIEUEEA.
BEMBER-XP, AW RIA> - I>O-F-—ERBLIDER
Scrub DSTE—RICADET, BtREGABICENDT ERED. REFFHA

|MICEDTERERULICRD., REIT 1/8x, 1/4%, 1/2x%, 1X, 2X, 4X, 8X,
16X T A—FT A AlF 2 ERFETRIZENTEFT,

Record Arming

FP—h=Ne b3Sy O(d. RECERIFICERESNE T . PLAY fFEIEF (XBESNE T,

T—LBERENE Sy OTE, A>7Y MEZS—D On TRULHE D, BREHNBLEDESSHWEE
PTEBELET, (I>TY MEZA—DONZESATA>TY hMEEZI—-UFET, )

FroxNaeF7—L9BClE:

1.

2.

nE9,

FroRIL - JT=BUET.
Arm &#FvTUFET,

P=LhSNEFvroxIE A—=F— - E2—DOHRTFv >RIESZRDSNILDRIRRE
BEUBDDF v 2RILERTL AU TESNTVDIHEE. TNSDINIILAEHERLTY
2OENTNBZEZRULET,
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Working with Cue-points

MixPre-3M (&, EBDESRHMIGRA > MOA— bIYFw o - JIF IN/OUT /R > hABEEICOT —
NI DHIC QRA> hZEFIFALET.

QRA> MIRRRDIATHHDET,

=P 1T g3

» Play In BAERBRDIBE, —#%MI(Z/)(>F - > (Record In)FIDT UO—)L
EUTHERENET,

. Record In BEM(CERERBRDIBE. (VO F1> - 7D NMESORER)

O Record Out BEIM (SRS T ROBE. (JOF1> - 7 MEEOER T =)

I:l Stop BEEIESADIBE. —MRMIC/F 7D M Record Out)EdmRX
rO—ILEUTERENE D,

Cue mark F1 - —OEFHPTERORSS I UCI—ITE, F(E0<H

@ (Q01, Q02,etc) HCOr—hg3ZENTEET, HIXIE. O-S AR QR
> hEEEL. COF1—IRA > MMTOMNDOPITNEFIZDIFTD
EETEFET,

QRA > h&EMTBICIT :

1. fBIrhiE. Q703> Q #4HvFUET, Home BFEICEESDE. Q-Points X =1 —EEHE
RENET,

Set 00:00.0 as
1 Back |Clrin/Out

2. BIUEWFI—RA> NMCHYETIRYSESYYTUET, F1—R1> FOEME. F1EH,
R—Xth, BEFDOWITNEDEETI,

Set 00:00.0 as
1 Back |Clr In/Out ﬂ

>
00:02.3 | 00:05.7 | 0O

C] Y

00:18.5

Info:  Out RA> REEBWZREIC In IRA> hEEL ZEEFETEEFRA. Y17 (Play 1
Record) D InHhOutiR1> hE 1 DUEEL CEFTEEREAS

Z7/z. Play In. Record In/Out. Stop 7R-f > % Cue-List No5F1 —~N—T&/ERIT D ENTEE
9,
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F1-—~—DZEMTSICS:

> §BET. BAH, R—XPC. TOMDESCEZDIAZSIT. Q711> Q (Home EED
FECHB) BYVTUET. F1—<v—IBS (Q01 HBIEED. HLLF1—MEmanark
DITEBXTWLK) (. Q7O DEICERRESNET,

>  Ffz. BIEUERRET Home BIEID EEBICHD Q 71> &AW IT LT Q-Points X =1 —
(CFOTERAUET, RIC. Q RF> 0] Z#IYITUT, MADOHY IR a>THFa1—%
EBITEFET,

ITCICHFELTVWDF 21—V —IBICEIAATIHLUS N —DZENUTZIHZE. MixPre (FBEEH(CES
ZIRD2H L. BDORIENS QO1, 02, 03, etc LWMAREZSNFT,

F1—(F. Q-List DR (CHFTRRSNET ., ROEHFIE. Q-Points BEEIDH T, Play In. Record
In/Out. Stop MTFIC 01 &EFXRESNTULET,

Cue List r
“1Back |ClrIn/Out ﬂ

Record In 00:05.7

Record Out 00:14.6
00:18.5
00:05.5

1 HICDERKX 20 ADF1—RA> MZERCENTEET, F1—(CEZFIZEDITD. BEL. HIBR.
»3U\& Q-List 55 Play In, Record In/Out, Stop R1> M EUTHREIT DS ENTEET,

Info:  Playback h Record In/Out /R > NMC&BIZEDITBDZEETEEEA.

Q-List [CPOERTBICIE:

» Music Control XZ”1—mn5
> Q-Points XZ”1—m5

1DDF 11—V —VIC&IZEDIFBICE :

1. Q-List (C72t X U. Q-Points BEEZEFR RIEET,

2. HPI>O—A%FERALT1IDDF1—Y—IU%BRUET,

3. NameZ%wU. Chorus ¥° Bridge &L\ TE#iLWLVERIZANE Y,

Q-Points ~

1 Back |ClrIn/Out
Record In
Record Out

I stop
01 Chorus

's¥d Bridge
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Play In, Record In/Out, Stop R1> MEUTF1—EHRETDICIT :

1. Q-Listh5, Fa1—%1DFRULET,

2. SetAs =9V ITUET,

3. Play In, Record In, Record Out, Stop OWLVITNHEFY T L, BRENcF1—%2ZEULFET,
Moving Q-Points

BREINcF 1 —DiZ 0.1 WEU CTEEIDICENTEET,

Q-points Z¥BEI BI(C(TE :

1. Q-List&®#&FvIFUZETY,

Cue List r
*1 Back |Clr|n/0ut ﬁ

Record In

Record Out

Play to preview

2. HPI>O—-A%EELT. 1 DD Q-point Z&ERLET,

3. Move Z45wvIF9dBh. HP I>O—4%&E LT, BIRENZ Q-point & 0.1 MBI THAEELTL
EE0N

Previwing Q-Points

Q-point DRSS 3> I 7A> - F1—_20FBEHIC. TLE2A—-FTBDENTEFT, JTLE
1—I(E. Q-point "SHHEEBELEI., BL Q-points MOITMNTEWVWEZIRBWNGE., A—TH
BERFEO>TZEDORSS 3> ZEZTF7A(> - F1—> LTSN,

Q-Points #27LE1—FBIClE:

1. Q-List 5 Q-point Z:#IRL T. Play Z#ULF9I,
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Clearing & Deleting Q-Points

Q-Points XZ=1—M Q-List BIEIT. F+1—~N—2®DHIE%. Play In, Record In/Out, Stop ODN¥—T%
DIUFPETRDCENTEFET,

In & OutEZIUF7IBICIE:
» ClrIn/Out 29wV L&Y,

{El2 d Play In, Record In/Out, Stop R > hEIUFTBICIL :

Q-List 5. »BUL\ &1 D%EEIRL. Disabl 5w FUET,

F1—X—VZHIFRTBICE:

1. Q-Lisths, F1—~X—0D1DZFERLET,
2. Delete #Z59vTUXET,

Locating to Cue Marks

DB BIIFTEDIRRIC “F1—" ULIEWEE. PLAY /RY> & HP T>O0—4A#FALTIIEW<Fa
—X—IONZv>2TITBENTEFET,

F1—I—IBNSVv>TTBICIE:
> B&ED R—Xh, HBVNHFLEP(C, PLAY R EHUEEELE HP T>O—4S &0 T & RD(F]
DYF1—R—DEZv>TIBDENTEET,

Punching In/Out
INOTF 2D E,. P—LBRESNEA—FT A AT —FDHD NSV IEBEURNS, F—ASNE S
WM in & out DB CHREIREECTIHMETT. A—bIFvo - )IOFTE—MCENOND
FOZWVIT. A—FA4APFEITD SV IEZBELDD. BENSEUINLRKHES5HUHROSN
JERA > NTREOROVIAY - PORSEITENTEEI., FTUWLWRSY I, Fzld, ITIC
A—F A APFEEIT DSV ILEICE, INOFA> - PORNTEEY,
FTICEMHDFEIETDLIC/)IOFA> - PO (A—)I\—FE T EMREND) (. I TICHRSZINE
rSwODET, Record In & Out CTHEESNEFEEBICHF UL A—F s AZELZETY,
FEITINOFA> - PORTBICIE:
1. )JOFa> - FPoOMUIEWSNSYOZETZ—NAREICUE T,

2. BAERIC, FROIAZITT/INOFA2IDEHC REC ZHUET . MixPre (F7—LASNiz
bSyOICHRELFI, RECI> MO—JLIZBED < HFBCRITULET,

3. E5—ERECZHIEL/CFFIRUET ., MixPre (FBEZHEITRENSHFSICIHELELET.
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BENCI>OFA> - PORTBICE:

1. MixPre ZBHEIMIC/\>F1> - VI RSHEZWWETA(C, Record In & Record Out 7/R-1> h&
HEULZEY. Record In M Out /R > MERESNDE. A— NIFVIINAFINET
HBDEERT P W RF—HRX - )= [CRRE=NFET,

2. WEICUT. pre-roll & post-roll ZERET DIEsHI(C. Play In & Stop @ Q-Points Z{ER L
F9, Pre-roll BLwF 4 >0 9B ET. I TICEBSNICESEZ Record In /R-1 > RKDFHI
NSBETDRCENTEDIDT. \OFARADEENIXZAHILIDRE—F 4 [LITAET. H
FHTIEU T, pre-roll & post-roll FDE=ZS—Y —RX% Track ‘Monitor’ RF>Z=FE>T. b~
SYIBENSATA>TY RDEESNIRETETET,

3. RECEHUZEYI., PLAY RYUHEREICHLTL. MixPre (& GRES=NTLWNUZL Play In/R-1> b~
N5, ZSTRIINEREDT LA\ - h—VILMIEHNS) BEERIBRLET. BELDD.
Record In7/R- > NMTET B E. MixPre (37— AN S YO TEBNICEREMIAEL. REC R
BHIUNTFREBICHITUET, 8] (L. Record Out 7R > RETDIE. ZTDRA > KT MixPre (&
BAEIREEICRD . PLAY RS R (ICRITUE I . BEX Stop R1 > MIET D EELEUET,

Bouncing

MixPre-3M (&, Z<DZF 1T —>IUICHISETEDIREAX 12 hSvoDLI—5F—T9, HIXE R
SLARBIC 4. R—XAIC 1. TA—HJLABIIC 2. FHY—RIC 2. F—R—RAIC 2 bSVUERFERALT
BEARTIC1 bV IKEDET,

LU, EELEEFED EZLDLAVT—PBRELRDINEULNFERA. EZRZ EFEND/IND2 2>
THEd. E— MLXWPE—FIR—A XX ENERUIZRRDT O I T, A-/N\—-FE>TRHDZE
NS ORIEDIZHICNILF RSV IZ 1 DMN2DICOIA>2FTBDZETT. ZNE YILF RS
DTN —E2TTDTETOEMIEZTY IRI I HDNEISO Sy OICU)N=TPITF7—T7T
IOREMNITBCEICERANDZENTEFT,

MixPre T(&E, /\D>X - TWOX(F LR Ty O EREZFIB L TLET,
NIDRTBICE:
1. NODRUEWNSYIZRDEY . INZTARATAR—23> - MSYITEFUET,

2. TARTAFR—23> - FSYIDFvRJUBEET. Input & MixL. MixR. F/z(dmA (CKRTE
LEYI. COFaARIE NIRAUEWEDNE/. XAFLA. TaTILE THINTRE
NET, FIZIE, track-1 & 2 (CRXFTLA/IND DX T D55, track-1 & MixL (C. track-2 Z MixR
([CERTELET. BUB track-3 (CE/SIL - NI X I BI/BE(E. track-3 & MixL & MixR Ol
(CEREULET.

Info:  MixL D MixR ([CERESNE b wvOlE. Ta— RN OZBETZ(C LR mix HMSELD
BROANET., BEENDIINOZADLRNIIVZE LRTA > MO—ILTHREIDZEN
TEX9I, Home BED L(left) SV IRAA—S -V T UL TITEWL LRTAIC
PITCATEET,
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10.

11.

IO ATD RS DIERDFET, INBZY—X - SV ITEHUFET.
V—REFTARTAFR—23> - FSYITLHMDIRTD RS Y I%Z Mute [CLFET.
TAATAR—23> - FSYILUHDINRTD NSy IZ2T7—LFERULET.

V=X« fSwOD levels, pans, reverb, air effects ZEBICIGUTEHRELET. TITTME
FTARATAFR—>3> - FSYVIICRRENFT,

CNTINI > ZADER/HENE LT,

FETHERSHI/ITDN. A—b - INOFABEETN\D S IZMIBLET . J—NILEEE
RBDT, UFPILEFALICY—R « 8V ID levels, pans, effects ZEN(CFAE T D ENTE
ESC®

NI R &EIESHEWEEIC Stop ZIHU TELETEET,

FTARATAFHZ =23« FSYIMS MiXL & MixR DixD &7 —LAEBEFRUED,

NI ZDFERZEEL(CE IND D ANRES — NESNEHEPNSBERRIALET . SV IXLAN
JL. pan, reverb, air &L TZE0)\,

INTOZRUE RSV OZRBIILUTEEL (CEF. AUSFILDY—X - bS5y D% mute 330\ HIFRT D
BENHDFET,

cSyD&OVFIBICE:

1.

2.

Fv FJVEREIC T IOTALET,
Input #4w L. RIC Clear 25V T UZET,

mic B[ 2 ][ 3 |

tne (1 ][ 2 [ 3 ]
Aux In 1 2
USB In 1 2
ixL ||[MixR||Click|| Phantom |
Clear ONX> RlE. RSV IICA—FTA AT —INBDEETRITRREINFET,

Info: boSwvOZEIIUF7IDE TOZTUMRENS NSV IZBMDBREET. WAV I7A
IWEERFELEIN, O2E1—FITOH7ITZATEET.

Yes 25y I LT, TJOZTOMSDRSYD - A—F+« AR LZHELE T,
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Metronome

A ROJ— Al BENCEERBDBIIAZIIEEBED. HIVNEEERNDEEINENDT S
N> THISEBHEETT ., N—DRIIDOE — NIMOE— REDEBVWEYFTEDEY, X ~OJ
—ADIUYIEE LR SYIREBESI. AW RIA 240 LR [CRESNEEHBF TR 2 &N
TEET,

AROJ—ABFDORSYID 1 DICESTIENTEET, HSULEVRSYIO Input BIE T
Click ZZBRUTL RS0\,

AROJ—LADBEETSICIE

1. = w5y IUET.

2. Metronome 45w U, %ELREEZITDOCLIEEUN,

ﬂ Metronome

<1 Back
Signature
4/4

Metronome

On During...

Count-in
0 bars

Volume
5

Info: HEEFRPE AO/—ADOTLELI-BZELZENTEFET,

> Sginature Z9v U THFERELET .
AT 3> 1/4, 2/4, 3/4, 4/4, 5/4, 6/4, 7/4, 8/4, 6/8, 7/8, 9/8
> TempoZ&HvITUTFIR (DUvOBFDL— ) & HP > 1—%4 T bpm (beats per minute)
BZHELEI . #HEI(E 40 ~ 240 bpm,
Volume Z4A v U TA MO/ —LADEEZHERLFET.
Count-in 247w LT, FRBFBAIOHND> MIERELE T, (& 0~8 bars.
On During-- &Y T U TWDA RO/ — LT O5 4 T(CIRBDHERELET,
ZA7F>3> : Record, Play, Count-in

YV V V

AhO/—LZBMTTBICE:

Music Control X Za—h5X O/ —LRY>  HZAVITUET., PO5TaTJICRDE A O —
L©DOTAANNAL B TERRISNET,

BALLAD BALLAD
History ﬂ 1 Back

Solo/Mute Cue List

A

Info: RSV ODA>2TY R V=X (COUVIERTHA>ENDE A MO —LRY(E
w2 (JLATINTALOZEBOTAOERR) T,

Cue List Solo/Mute

Render Render
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Record Settings

Record T A=1 —Tld. JROKXRDX D (CEHHIASTE

REEENSDDET,
BIAZ1— ¥l AF3a>
L&R Gain LR SV ORXHEDT A E - -30-0dB (1dB XFwv7)
Info: Home EIE C L(left))KFA—F—EHVTITDE. LAR A 2 (CT(FRL< 7ot
ATBDCENTEET,
AAC Quality AAC L >AY > DEERTE. - 32 kbps
- 64 kps
- 128 kbps
- 192 kbps
- 256 kbps

Record B AZa1—[CFHOERTBICIT :

> = mAIvILTHhS. Record 29V ITULET,




USB

USB Audio Interface

MixPre-3M (. 5-in, 2-out ® Mac " PC O>E1—4 EFERT B7=D core audio > /\F )L
A—FA4A - A2H-T1T-R=ZERNBFELTNET,

PCI1—Y—Diza. FED ASIO RS/ > XA b—)LESNRVRD, 2x2 A—F 1 A5 —
J1—X&EUT MixPre-3M WEBiieNZE 9,

BHD ASIO RSAIN—EA2AM—ILA VARSI E UTHhSERN TSI DI O— RTEET,
www.sounddevice.com/support/downloads

RARNIDEZ—IMNSUSBA—FT 4 AL LTEHNEDBI(CIE. USB1-2 V—XEBEYTIL— T Db
BENSHDEI, RXRIE1—FHSD USB A—F+ A& MixPre-3M DANTHDSAITA—F
A A%Z—FE(C LR JNANZE D TV IR UIEWEE, FroRILBE@EZE> T2y b —X%&IR
ULTLIESV. USB ARR NI E1—FA—FT 1 AZAY RIA>DTESEZIFTHNE. HP UL
w % USB 1,2 [CERELTLS S0,

MixPre-3M (& USB ;RX MDA KNI —Z>2T « A—F 4 A LBSEREICITDEEDNSHDEI, £
e OEa—9IN5D USB A—F A - ANJ—AHN%E SD Hh—R - LO—4 —TEEHRSEI D
BEHNEHNET, NEHSWRIAE1I—IR—IADBEELCBSVWTCIERCEFREETT,
BITFDORE. MixPre-3M OF v > FI)LHN USB A—F 4« ADHEIANTHA > ZNBHMCDVTRLUE
ER

BUFdDEER(FE. MixPre-3M OF v > RILDENTDEIDEHTZRUE T,

HBIOAZ1— £

Track 1 USB stream 1
Track 2 USB stream 2
Track 3 USB stream 3
Track 4 USB stream 4
Track 5 USB stream 5
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Low-latency Monitoring

L1572 (A—FaADTOLYI 2T - FTaLA) BINSLTBEHIC, I\ —RDOTT7, O>vo,
VIRITTDTHA D F—AFIFRBICEFUTHSTLUELUE. Z<DRRICHLT. DAW(Digital
Audio Workstation)ZiB U CEZA U T IR ESDL AT (E DAW VI NI 7, TS5040>.
O>Ea1—AD)\—RIUTT7RET, BR(CHBHHEICHDET,

2W—"TY s LAFTUIHEFENBIEDRIDEFZNIEE CEERBMNELY) (C(E. MixPre-3M (CAS
SNBESEANY RIAEDTCEEBE-SY—IBICENTEFET,

Zero L1523 TAY RIAEZHA—TBICIT:

1. MixPre-3MZ 1> E1—4HTIEHKELET,

2. HP Preset &L T “LR Stereo” MEREN TR EEERLET .

3. Track 1 AIC"USB1” %##&ERL. PanL [CLUET,

4, Track 2 BIC"USB2” %##RL. PanR (CUET,

5. 1>Fv bk 3CRATOTANERREDY —AZIEHRLUET,

6. Fv>RILIAEOEYRA>TY hMBEBIRULEY., cNBEFIO>E1—FT USBAMJU—A 1-3
[CZNTNIENET,

7. DAWYIRITFPTUSB A hJ—A 1-3HYV—RERDFULWRSYIREZEL. CORSY
ODLIA—R - EZAUINEBENTHDCEZHRUET. (£, SDAIC DAW AD S
wOIDHN%EZ21—MUTHEET, )

8. Fv>xIL1,2&EBUTDAW A—F 4 ADEIZFAEL. NV RIA>DTELZENTEET,
Ff=. Channel 3D/ JZFERALTAY RIA>ZTEZA—NDIEL AT (& DAW ([TXS
N3LAR)) ZAEIDZENTEEI., Channel 1,2 /T T DAW A—F+ A& Channe3 D
SWORERABLTLLES0,

USB File Transfer

MixPre-3M (&, USB #EfitcN/e/RX RO Ea1—4 EANE SD H— REID T 7 1 JLEREEYR— MU

F9, COHBEHR(EDSI(CIE. MixPre-3M #& File Transfer E— RICURRITNERDFEFA. (USB A

— T ABLEE(SERNCIRADE T, )

SD Hh—RZIA—-Y MTBICIT:

1. = &#YYITULFEY,

2. System > File Transfer 5w UZE T,

3. J7AIEERETLES, LO—4A—%20>Ea1—4aMnS5EmD4LET. RIC USB-C File
Trnaser E— REIED Exit #45w S LT, BIOERIREEICRUET .
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USB Keyboard

25— K USB AVE1—4 + F—R— REYR—RLTVET. MixPre-3M ZEALTUNT,
AGF—HAA. G4 MRS, DA7—UE— RI> FO—JUEEDSBEE SNB E=(F, USB F
—R— REEH LT REE,

Info:  USB J\TH'HEESNzF—R— RY> Apple BDF—R— RIFHR—ELUTWERA
FJz. MixPre-3M DOEIFZ ANTZE(CEHR UIRWERHESNIRWEDEHDFET,

EHaNz USB F+—iR— R(E. MixPre-3M oW DHh\DO#gEE D E— > bO—I)LI D EETE
F9, UTDxERIE. USBF—R—RD>3—hkAHY MOUXKRTT,
USB Keyboard 3—bkAhv b

USB F—/R— RMMERIESNDEF,. DEDF— - A ER—>3>FEFS3—bhy MBEMTT.

F—1%E sl

F1 » Menu F— XA~ Menu N7

F12 Home

Ctrl + R Record

Ctrl + S Stop

ZAR—RF— Play

EHh—VILF— AAVEE: VDA R BA3DQRA MNIZv T
Menu & Ch EHE : R—ZDH)E

HmHh—=VILF— AAVEE : TP ARIADT—R, IO QRA> NIZv >
Menu & Ch E@ : R—ZOYIE

EFH-VILF— XA EME : A\Y RIA>B=HEE

Menu ™ : T>O—4MERRIECED S, (RTO-)LUXX NRE)
IS AL —IRER : BOEE

Enter +— Menu A : IRFEDEIREEMC (T>O—FMUICED D), I\—F
v I)LF—R— ROBEREFIC OK DEREF U,

Q Menu A : BEIE®D 4 DDRE > DE_E#ER,

W Menu A : BEID 4 DDNY > DA %8R,

A Menu A : BEID 4 DDNY > DET %Z3&IR,

S Menu A : BIEID 4 DD > DA T Zi&IR,

1-3 1-3® Ch EHHE
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MixPre-3M
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User Presets and System Settings

Saving and Recalling Presets
JLF2EUF oM MixPre-3M O TCI, SEIFRSIF1IT—>3>TLO—4F—%RE(CEDS
2T MixPre-3M DETOLYFT 4 >0 A RFZUIEDUI—I)LUED TEBRLSHETSNTLET,
YT D ORERIDIEHOTULY & - 2OV MIIRERERC 4 DHDET, £z, SD H—RI(C
TUty hEI NPT IHEEF. TUtY MUSIEEFHIEANSDDEE A
Uty MEREITBICE:
1. E w#IYVITUET,
2. Presets #4w . Internal 1-4 /" SD H— RICREFELZE,
3. FEOTULY hR—LBEANT, OKESAYVIUET,

Tty hERFIDICE :

1. = BYYIULFEY.

2. Preset > Load Preset &5V FUFET,

3. I>O—-4#bBIULTERBOT LY hZ#IRULET,
4. OKZEAHVIUET,

51



User's Guide

System Settings

SATLEECTICLRATSICE :

1. = BYYIULFEY.

2. System&EZ&SvIUEY,

NR=S | BIJAZa— 3]

1 USB-C USB-C /R— %, BROH. BDINIA—FT 1 AADICERITIH%E
FRTE .

1 USB Audio TILFFv )L USB A—F« AICHIELTWRWTI UG —2 3>
AEDTIBEESOHBIZHIC. USB A—F1AA(>F—TIT—R%E 2
Fr RIVETOERCERET DS ENTEET,
#A7>3>: Normal/ Stereo Out
Info: Stereo Out (CE¥E I D &L MixPre (> Ea1—4H5 USB A—
FAAZZITENBLIADET,

1 File Transfer MixPre E7RA RO E 1 —SBID T 7 1 JLERX,

1 Tone ~—>AES®dD On/Off.  (LAR)L%Z -20dBFS H5'5 0dBFS & T 1dB X
Sw I THER, E— K% Continuous H* L-Intent (L% ET].)

1 Limiters U=wv A5 —#EedD On/Off,

1 Brightness Sy FEmEE) > LED OIEEZ TNTHERE.,

2 Date/Time B, B, RREXDKRE.

2 Regulatory MixPre-3M (CB89 3 FCC O> 51 7> X EHR.
FCC ID: 2AKLX-739M6
IC: 22225-739M6
HVIN: MIXPRE6M

2 Version J7—ALIDTT7IN—3 > B ESUTILES,

2 Update Firmware SD H—REDIT7AILHS MixPre DT 7 — LD T7ETYVIT— K,
BHOI\—>a> O IR—HhB845D> 00— RTEEY,
www.sounddevices.com/support/downloads
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Remote Control

Wingman Application

Sound Devices Wingman (. - Google Play & App Store W54 D>0O—RTE3 - JU—app
T. Android H"iOS #iEM S MixPre = U —X® Bluetooth Smart ®UE— > bO—ILZTDE
DT,

MixPre L J—% —T Bluetooth ZB#IC T BIC(T :

1. = mYYITUET.

2. System > Bluetooth &AW FUET., CNICTKD Bluetooth #EE%Z On/Off TEE T,

Info: HBLLO—F—LETUE—-NRXDT—-RMNKESINTWNDE. Wingman (IIEGFIART
(C)I\RT— RODANZERDET,

i e—— Status Bar
M

Stage Jam

00:01:33:6
X

a Viewing Area

WINGMAN

| Track 10
'Track 11
| Track 12

. -
=
=2ile
9 | |-
—E-
-l
i L
5 ]

3 IVek main

| [Guitar|

= [Guitar 2

= |Agolistic DI
¥ Percussion

4 Bass

-
(=]
—i
-
=
~

Tab Bar
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Wingman O4& Y FEEA 25— T T —X(E. 3DDAA TP CREERIEEEZSYU > IZIRHEL
ijo

0 RAF—HR - FT)\A RDFMRBERE R

e EBa—IVU7 -r3Z>RXO> ORI XIF—=FT4—=)LR, LRILA=FDHD
SOZR—=h - Ea—EWDEERBRIU—-> - Ea1—DFR.
HHCR DA E>D U TD A =5 —(Z NI ILEIE,
NI i0S /)N AT Wingmann app ZFI3 3 &=, KEICRDTAETIULT. S RAR—
N RSwo - Ea1—RDUE.

@1 111E %% a
Stage Jam

‘s 00:00:48:7 ')
O® = >

@t 11 E ®N7T

L MixL
R }MIXR

¥ Vox main
» Guitar 1
1 Keys
<

Guitar 2
» Drums OH L
+ Drums OHR
P ' BASS
\\ il |Acsiistic o1
/< \ % Percussion
‘ W Track 10

\ 5 L W Track 11

| Track 12

o [0 [0 e ol ) 2

Transport View
Track View

Tab/)\— - 9T FEDBAEA TERICRRSNTVWTADDT7AIAMHODET . FileList LU\

D E I —(C7OERT Db TZFRALET.

Info: INESENAILFTINAATIE. DRILFZ—LERNSTYIT—AIE Track E1—TIRIET
=, KBE/NAILFT/\A XTI Transport E21 —TIETE XY,
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Connecting to a MixPre Recorder

HLU. Wingman ZFIFTZ 3 Sound Devices 7/ 1 AN E# B DIHBE. Wingman (HEEEH (CHD
BNRTINAZIMNIARTERRUET, Connection 771 I>%&45w T U TERTLDT /1 % app 'S5
DBZBZENTEET,

Info: RUBBEBOL I —=EHBFBIIEETE. ATEHENZ i N—D0&FvITDE
DL -4 —Em(C Identifying from Wingman” 2wt —hERRSNBDD T,
EULWFI\A RZR#MIT DDICEIBET,

B8 T 40100% W 3:41 PM

Devices Found

MixPre-3 Serial #: QB0317012004 ®

Identifying From

wingman Device:
MixPre-6 Serial #: QC0117030014 ® TRy

MixPre-10 Serial #: QD0117206003 ®

MixPre-3M Serial #: PW0018081001 ®

MixPre-6M Serial #: SG0018100002 ®

MixPre-10M Serial #: RT0017339009 ®

Wingman H'EEHR. [EifE (C Sound Devices O D7 I DETEGIRNAHN RESNE T,

Hh5— rZA4d> AT—HR

gL+ @ R - /A ROARTE. FLEFT/INAZARFrZ>TmHh,
AL> Bluetooth #&#u&H,

A4IT0O— EfHR - FEb&T.

gu—> R - AT T

Music Projects via Wingman

Wingman 77U ® ver3.20 BIEET. M EF)LD MixPre = —X, Musician Plugin N 7OFR—
& MixPre E5 /L&D Bluetooth iB{EZH/R— MUFE T,

MixPre &1t d D&, MixPre U —X ETHEHANTWBR IO T M #EBHESNTLWDIEFTILICHD
T. Wingman O1—Y—A>5—-J1—IANEHDET,
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% 00:01:16:4
o & >

Drums OH R

-
T
O
)
£
=
I
=

= |Mox main

~ Guitar 1

o 'Keys H

B 'Guitar 2

= IAcoustic DI
Percussion
Track 10
Track 11
Track 12

gt=]
—
=]
—
—
—
L]

Info:  EFIITOZTUMCEFRERLS, REBEOE/N\AILT/I\AATIEFS AR -
Ex1—T. NEHOENAIILFT/NNAATEISYT - E2—T. BRAILR—LEDL
SYITV—LEHECETFET,

rSYIOR—LZwETSICII:
1. ROWITNHZEIRIELET,
> REEE/AILT/INARXT. FSZR—b - Ea—m5. RELIZVWRSYIDA—EF—D
EThEFYFULET,
> NEEENAILT/IAXT, hSvT - Ea—Nm5. RELEVWRSYIDA—F—DETH
ZFYVFUEY,

2. BEEOIN—FvI)L - F—R—REFO>TrSYVIR—LERELET,
3. Done&x4AvISUTCEEZHEELEY,

Info:  F—IR— R DMMDIBARIZS YT T L. REZF v ILTEFT,

NSV O%T—L/T7—LRIFTSICE:

> A—H-—SNILZIYTUET., F—ASNBIERBICEDDET, FroRILHAOnTI—A
PMEEBRENDESNILIIIREBTY ., FoRILA Off EESNILIZEBBTTV —LARETCETEz A,
Music project TF v >RILM On TV —LBRESN TV, BERHNA—/N-FE>THDS
NILIFHZEETT,

Info:  Fyr 2RIV TESNTUVDBE, BDEIA-F—SNILNEARLT. 1 DDA
IWEUTRRESNET,
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USB Controllers

Ver 3.00 A E®D firmware iS5, MixPre U —X (M EFILEZSD) (CH— RIN—F1&®D/\—RD
T7 - > MO—S&EHUTRERZIFI 2D, LO—FTa > JBBTHEEIDITENTEET,

EaEIE. Ry b X b BIGAOA —F« ARS(CRST . H5B3T7TVT—3> (BT,
20> MWERILD J TX¥° Bluetooth BEICKDE/NAILTINA ZINSDUE— MEFECIZ T, /\—
ROx)7 - 0> hO—-SH&EBMT D ETED—E MixPre OEFEEN,EILEULET,

MixPre =1 —X(&. JRD USB > hO—SHhSRIEFI DI ENTEFET,

Korg NanoKontrol Studio

Korg NanoKontrol 2

Novation LaunchControl XL

Akai MidiMix
cnsoId> hO—IL - B—=Jx—X(&E TA4ZHI - AS5AF— Ry b REYIRET, Tx—
H—LN)b. NULGA> )N, UN=TtE> R vO. ZTa—b, REC 7—=24, hS2R
— b - OO ZREITDZENTEFT,

Info: IXRTOHENIARTOIO> FO—STHR— SN TLBIDITTEHBDEE A

Connecting the MixPre to a Controller
MixPre & USB > hO—SDEGMEZBME(ILT Dz, 1 AD USB &—TILICKDIBIE EEBRME
MTONEY, F\EHRSNZIS MO-SOEBREZEE(CT DICH. MixPre (FEirSnizd> ~O—
SICEDETEBNICEBRENET.

Info:  MixPre-3 &£-6 (&, BEMHEHNARRIBDEEENE— RICAD., USBR—OMERATE
R<IEDFET,

> bhO-SzExRd Bci3:

1. MixPre D USB-A/R— MMCUSBT —JILDO—imZBEALE T, O inlHMEA T DHERCESHE
7= USB-B, Micro USB, Mini USB OS50 &iD %7,

> hO—SIfABLIEUSB O —J)ILZERITICEa2DEHULET,
Info:  MixPre DEBRMNADEIREETOY MO—S%iEHU CERIED D EE A
2. MixPre ([dEHiaNzd> bO—SICENETEEBNICHEBAZRIBLET . BOEFRITIN. BE@m
[CEFEHRENZO> FO—SDORINRY T 7Yy T UET, #HE. Ry T7vTEEASERTZ
53> bO—S—I(XERATEETT,
Info:  MixPre (C#BficnNd &, —SOHEEN TS bO—SAICKEITI DIz, TDHLEE(E

MixPre L TIETERL<KKENDET, > MO—-SDOEFILICKDEIN, fader,
trim, pan, reverb send, low cut filter 71X EDEBENEITUE T,
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Map User-Definable Buttons to Shortcuts

0> hO—5 DRI A ) TDEI% MixPre LOIFEDKBECHAINAXTDENTEET,
THA D TEDIHERLUTTY,

Tone

L/R Mute

X1/X2 Mute

Undo (Audio project dMd+)

Slate Mic (MixPre-10T @ Audio Project dDd+)
Metronome (Music project dDdr)

Add Q (Cue 7R-1> ~ESN)

Record

Stop

Play

Rewind

Fast Fwd

Shuttole (IARTHOI> bO—FICHIHUTVEEA)

> bO—5DOIRY > [CHREZZID Y TSICIS :
1. J>hO-S=ERLET.

2. MixPre @BEIE T. Menu > *Shortcuts > Control Surface (C77OTAUZET.
3. PFHOMEERETERIEEIRRI U (CEIDHETET,

Controller Interface

TNTN. B—RIN—Fo®O> bO-S(CL>THEWLWBEFEMNMEWNE T, ROottos3>Tc &>
rO—ZSOFHICDVLWTERBELET,

Info:  MixPre-M =) —X(&. Audio project #HR—KUFEEA.
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Akai MidiMix f >#—J1—2X

FUNCTION

Music PROJECTS

Aupbio PROJECTS

Fader Bank Switching

Bank Left = Select fader bank to
the left

Bank Right = Select fader bank to
the right

User-Definable Shortcut
Buttons

Solo + Bank Left
Solo + Bank Right

Solo + Bank Left
Solo + Bank Right

Record via user-definable shortcut via user-definable shortcut
PLAY via user-definable shortcut via user-definable shortcut
STOP via user-definable shortcut via user-definable shortcut
FFWD X2, X16 via user-definable shortcut via user-definable shortcut
RWD X2, X16 via user-definable shortcut via user-definable shortcut
Skip Next File -- via user-definable shortcut
(Tap Fast Forward)
Skip Prev File -- via user-definable shortcut

(Tap Rewind)

Skip Next Mark

via user-definable shortcut
(Fast Forward)

via user-definable shortcut
(Fast Forward)

Skip Prev Mark

via user-definable shortcut
(Rewind)

via user-definable shortcut
(Rewind)

Return to Zero

via user-definable shortcut
(Stop twice)

via user-definable shortcut
(Stop)

Shuttle

Only via MixPre

Only via MixPre

Record Arm

REC Arm button

REC Arm button

Record Arm Status

Red REC Arm button when armed

Red REC Arm button when armed

Input Monitor

Solo + REC Arm buttons

Input Monitor Status

Red REC Arm button when Solo is
pressed

Channel Screen Access

Solo + REC Arm buttons
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pressed

FUNCTION Music PROJECTS Aupi1o PROJECTS
Faders Linear faders 1-8 Linear faders 1-8
Trims Top row knobs Top row knobs
Pans Bottom row knobs Bottom row knobs
Reverb Middle row knobs --
Low Cut Only via MixPre Middle row knobs
Mute Mute button Mute button
Solo Solo + Mute buttons Solo + Mute buttons
Mute Status Yellow Mute button Yellow Mute button
Solo Status Yellow Mute button when Solo is Yellow Mute button when Solo is

pressed

L/R (Stereo) Output Gain

Master fader

Master fader

L/R (Stereo) Output Mute

via user-definable shortcut

via user-definable shortcut

X1/X2 Mute (10M/10T only)

via user-definable shortcut

via user-definable shortcut

Tone via user-definable shortcut via user-definable shortcut
Metronome via user-definable shortcut --

Create Q via user-definable shortcut via user-definable shortcut
Undo Only via History List on MixPre via user-definable shortcut

Internal Mic (10M/10T only)

Only via Input patchbay

via user-definable shortcut

SEND ALL Button

Sends all current fader, knob
settings to MixPre

Sends all current fader, knob
settings to MixPre

Korg NanoKontrol 2 >4 —2J1—2X

FUNCTION

Music PROJECTS

Aubpio PROJECTS

Fader Bank Switching

Track < button = Select fader bank
to the left

Track > button = Select fader bank
to the right

User-Definable Shortcut

Cycle + Marker Set

Cycle + Marker Set

Buttons Cycle + Marker < Cycle + Marker <
Cycle + Marker > Cycle + Marker >
Cycle + << Cycle + <<
Cycle + >> Cycle + >>

Record Record button Record button
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FuNcTION Music PROJECTS Aupio PROJECTS
PLAY/Pause Play button Play button
STOP Stop button Stop button
FFWD X2, X16 Hold >> button Hold >> button
RWD X2, X16 Hold << button Hold << button
Skip Next File - Tap >> button
Skip Prev File -- Tap << button

Skip Next Mark

Tap >> button

Tap >> button

Skip Prev Mark

Tap << button

Tap << button

Return to Zero Tap Stop when stopped Tap Stop
Shuttle Only via MixPre Only via MixPre
Record Arm R button R button

Record Arm Status

Red R button when armed

Red R button when armed

Input Monitor

Cycle + M button

Input Monitor Status

Red M button when Cycle pressed

Channel Screen Access

Cycle + S button

Cycle + S button

Faders Linear faders 1-8 Linear faders 1-8

Trims Rotary knobs (set to trim) Rotary knobs (set to trim)
Pans Rotary knobs (set to pan) Rotary knobs (set to pan)
Reverb Rotary knobs (set to reverb) --

Low Cut Only via MixPre Rotary knobs (set to low-cut)
Mute M button M button

Solo S button S button

Mute Status Red M button Red M button

Solo Status Red S button Red S button

L/R (Stereo) Output Gain

Only via MixPre

Only via MixPre

L/R (Stereo) Output Mute

via user-definable shortcut

via user-definable shortcut

X1/X2 Mute (10M/10T only)

via user-definable shortcut

via user-definable shortcut

Tone

via user-definable shortcut

via user-definable shortcut

Metronome via user-definable shortcut -
Create Q Marker Set button Marker Set button
Undo Only via History List on MixPre via user-definable shortcut

Internal Mic (10M/10T only)

Only via Input patchbay

via user-definable shortcut
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Korg NanoKontrol Studio 1 >%—J1—2X

FuNcTION

Music PRoOJECTS

Aubpio PROJECTS

Fader Bank Switching

Track < button = Select fader bank
to the left

Track > button = Select fader bank
to the right

User-Definable Shortcut

Cycle + Marker Set

Cycle + Marker Set

Buttons Cycle + Marker < Cycle + Marker <
Cycle + Marker > Cycle + Marker >
Cycle + << Cycle + <<
Cycle + >> Cycle + >>
Record Record button Record button
PLAY Play button Play button
STOP Stop button Stop button
FFWD X2, X16 Hold >> button Hold >> button
RWD X2, X16 Hold << button Hold << button
Skip Next File -- Tap >> or Marker >button
Skip Prev File -- Tap << or Marker < button

Skip Next Mark

Tap >> or Marker > button

Tap >> or Marker > button

Skip Prev Mark

Tap << or Marker < button

Tap << or Marker < button

Return to Zero

Tap | < or Stop when stopped

Tap |< or Stop

Shuttle Press MixPre HP encoder or set Press MixPre HP encoder or set
Shuttle as a shortcut, then use Shuttle as a shortcut, then use
selected shortcut and scrub wheel. |selected shortcut and scrub wheel.

Record Arm REC Arm button REC Arm button

Record Arm Status

White REC Arm button when armed

White REC Arm button when armed

Input Monitor

Select button

Input Monitor Status

White Select button
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FUNCTION

Music PROJECTS

Aubpio PROJECTS

Channel Screen Access

Press Cycle so that it’s illuminated,
then press a Select button

Select button

Faders Linear faders 1-8 Linear faders 1-8

Trims Scene 1 then use knobs Scene 1 then use knobs
Pans Scene 3 then use knobs Scene 3 then use knobs
Reverb Scene 2 then use knobs --

Low Cut Only via MixPre Scene 2 then use knobs
Mute Mute button Mute button

Solo Solo button Solo button

Mute Status White Mute button White Mute button

Solo Status White Solo button White Solo button

L/R (Stereo) Output Gain

Only via MixPre

Only via MixPre

L/R (Stereo) Output Mute

via user-definable shortcut

via user-definable shortcut

X1/X2 Mute (10M/10T only)

via user-definable shortcut

via user-definable shortcut

Tone

via user-definable shortcut

via user-definable shortcut

Metronome via user-definable shortcut -
Create Q Marker Set button Marker Set button
Undo Only via History List on MixPre via user-definable shortcut

Internal Mic (10M/10T only)

Only via Input patchbay

via user-definable shortcut

Novation LaunchControl XL 1 >4&—J1—X

FUNCTION

Music PROJECTS

Aubio PROJECTS

Fader Bank Switching

Track Select < button = Select
fader bank to the left

Track Select > button = Select
fader bank to the right

63



User's Guide

FUuNCTION

Music PROJECTS

Aubpio PROJECTS

User-Definable Shortcut
Buttons

upP

DOWN

Device + UP
Device + Down
Device + Left
Device + Right

upP

DOWN

Device + UP
Device + Down
Device + Left
Device + Right

Record via user-definable shortcut via user-definable shortcut
PLAY via user-definable shortcut via user-definable shortcut
STOP via user-definable shortcut via user-definable shortcut
FFWD X2, X16 via user-definable shortcut via user-definable shortcut
RWD X2, X16 via user-definable shortcut via user-definable shortcut
Skip Next File -- via user-definable shortcut
Skip Prev File -- via user-definable shortcut

Skip Next Mark

via user-definable shortcut

via user-definable shortcut

Skip Prev Mark

via user-definable shortcut

via user-definable shortcut

Return to Zero

via user-definable shortcut
(Stop twice)

via user-definable shortcut (Stop)

Shuttle

Only via MixPre

Only via MixPre

Record Arm

Select Record Arm, then Track
Control button

Select Record Arm, then Track
Control button

Record Arm Status

Red Track Control button when
Record Arm is selected

Red Track Control button when
Record Arm is selected

Input Monitor

Track Focus buttons

Input Monitor Status

Illuminated Track Focus button
Monitor is On

Channel Screen Access

Hold Device button, then Track
Focus button

Track Focus buttons

Faders Linear Faders 1-8 Linear Faders 1-8

Trims Top row of knobs Top row of knobs

Pans Bottom row of knobs Bottom row of knobs

Reverb Middle row of knobs --

Low Cut Only via MixPre Middle row of knobs

Mute Select Mute, then Track Control Select Mute, then Track Control
button button

Solo Select Solo, then Track Control Select Solo, then Track Control

button

button

Mute Status

Red Track Control button when
Mute is selected

Red Track Control button when
Mute is selected

Solo Status

Flashing Track Control button when
Solo is selected

Flashing Track Control button when
Solo is selected

L/R (Stereo) Qutput Gain

Only via MixPre

Only via MixPre

L/R (Stereo) Output Mute

via user-definable shortcut

via user-definable shortcut

X1/X2 Mute (10M/10T only)

via user-definable shortcut

via user-definable shortcut

Tone

via user-definable shortcut

via user-definable shortcut

Metronome via user-definable shortcut --
Create Q via user-definable shortcut via user-definable shortcut
Undo Only via History List on MixPre via user-definable shortcut

Internal Mic (10M/10T only)

via Input patchbay only

via user-definable shortcut
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Specifications

Audio Inputs

NAME

DESCRIPTION

Frequency Response

10 Hz to 40 kHz +/- 0.5dB re 1 kHz @ 96 kHz sample rate

Total Harmonic Distortion
(THD)

0.005% max (@1 kHz, 22-22 kHz BW, gain=20 dB, -10 dBu in)

Equivalent Input Noise
(EIN)

-130 dBV (-128 dBu) max (A-weighting, gain=76 dB, 150 ohm source impedance)

Inputs

Mic: XLR active-balanced; 4k input Z

Line: XLR active-balanced; 4k input Z

Line: Ya-inch TRS active-balanced; 4k input Z

Aux/Mic in: 3.5mm TRS, 2-channel unbalanced; 100k input Z
USB Audio: 4 channels

All inputs fully RF-filtered and overload protected.

-
-
-
-
-
-

Gain

® Mic input: +6 dB to +76 dB

* Line input: -20 dB to +30 dB

e Fader: -inf to +20 dB

* Total, Mic-to-recording (max): +96 dB

® Aux In (Mic): 410 dB to +40 dB

e Aux In (Line): -10 dB to +20 dB

* Total Aux Gain including Fader, Mic-to-recording: +60 dB

ADC Dynamic Range

32 bit precision; 120 dB dynamic range min (A-weighted, gain=10 dB, fader=0 dB)

Maximum Input Level

e Mic XLR: +14 dBu (limiters on or off)

e Line XLR / Ya-inch: +28 dBu (limiters on or off)
e Aux In (Mic): -10 dBu

e Aux In (Line): +10 dBu

Limiters

Limiter at all gain stages, range > 40 dB.
First stage analog, subsequent stages digital

Low Cut Filters

10 Hz to 160 Hz (adjustable), 18 dB/oct. First stage analog, subsequent stages digital

Microphone Powering

o Mic XLRs: 48 V via 6.8k resistors, 10 mA each

e Mic 3.5 mm: 3V @ 3k source Z
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Audio Outputs

NAME

DESCRIPTION

Stereo Out

DAC feeding Stereo Out,
Headphone Out

32 bit precision; 115 dB dynamic range (A-weighted)

Headphone Out

Output Limiters Digital
Recorder
NAME DESCRIPTION

Maximum Record Tracks [12 tracks

Sampling Frequency ® 441 kHz * 96 kHz
® 48 kHz

Bit Depth D4

Media Type * Secure Digital Extended Capacity (SDXC)

» Secure Digital High Capacity (SDHC)
= Secure Digital (SD)

Maximum Storage Size

512 GB (SDXC)

Card Format

e FAT32 formatted (32GB or less), exFAT for (=32GB)

File Type

* Monophonic WAV
AAC (render)
Stereo WAV (render)

Max WAV File Size

]

4GB; Files seamlessly auto-split at 4GB

Effects » Reverb types: Plate, Room, Hall (48 kHz max sampling rate)
= Vocal Air
UsSB
NAME DESCRIPTION

Audio Interface (USB-C)

5-inf2-out; 44.1 to 96 kHz; 16/24 bit; Class compliant USB 2.0 high speed or
ASIO driver (supplied via download from Sound Devices' website)

Mass Storage (USB-C)

USB 2.0 high speed

Keyboard (USB-A)

Text entry and control
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Touch Screen

NAME DESCRIPTION
Display 1.6-inch, color, sunlight-viewable IPS LCD
Resolution 320 x 256
Remote Control
NAME DESCRIPTION

Keyboard (USB-A)

Text entry and control

Power
NAME DESCRIPTION
AA Batteries “x AA sled or 8x AA sled (NiMH or Lithium recommended)

L-Mount Batteries

MX-LMount: 2x L-mount sled for hot-swappable Li-lon batteries

From Computer

Bus-powered via USB-C port. Use either:

e USB-C to USB-C cable
o MX-USBY: USB-C to dual USB-A Y-cable

AC Adapter MX-PSU: 15W PSU w/USB-C connector; includes wall adapter plugs for US, UK, Australia,
and Europe
Environmental
NAmE DESCRIPTION

Operation and Storage

* Operating: -20° Cto 60° C
» Storage: -40° C to 85° C
* 0 to 90% relative humidity (non-condensing)

Dimensions and Weight

NamE

DESCRIPTION

Size (Hx W x D)

* 1.4in%x568inx4.35in
36 mmx 144 mm x 110 mm

Weight

16.8 oz (unpackaged, without batteries)
0.48 kg (unpackaged, without batteries)

.

@ All specifications at 48 kHz sample rate unless otherwise noted.
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MixPre-3M
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Software License

End-user license agreement for Sound Devices MixPre Series Software / Embedded Firmware

Important Read carefully:

This Sound Devices, LLC end-user license agreement (“EULA") is a legal agreement between
you (either an individual or a single entity) and Sound Devices, LLC for the Sound Devices, LLC
software product identified above, which includes computer software, embedded firmware, and
may include associated media, printed materials, and “online” or electronic documentation
(“SOFTWARE PRODUCT"). By using, installing, or copying the SOFTWARE PRODUCT, you agree
to be bound by the terms of this EULA. If you do not agree to the terms of this EULA, do not use
or install the SOFTWARE PRODUCT.

Software Product License

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties,
as well as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed,
not sold.

Grant of license. This EULA grants you the following limited, non-exclusive rights: In
consideration of payment of the licensee fee, Sound Devices, LLC, as licensor, grants to you,
the licensee, a non-exclusive right to use this copy of a Sound Devices, LLC software program
(hereinafter the “SOFTWARE") on a single product and/or computer. All rights not expressly
granted to licensee are reserved to Sound Devices, LLC. Software ownership. As the licensee,
you own the hardware on which the SOFTWARE is recorded or fixed. Sound Devices, LLC shall
retain full and complete title to the SOFTWARE and all subsequent copies of the SOFTWARE,
regardless of the media or form on or in which the original copies may exist. The license is not
a sale of the original SOFTWARE.

Copyright

All rights, title, and copyrights in and to the SOFTWARE PRODUCT (including, but not limited to,
any images, photographs, animations, video, audio, music, text, and “applets” incorporated into
the SOFTWARE PRODUCT) and any copies of the SOFTWARE PRODUCT are owned by Sound
Devices, LLC or its suppliers. The SOFTWARE PRODUCT is protected by copyright laws and
international treaty provisions. Therefore, you must treat the SOFTWARE PRODUCT like any
other copyrighted material, except that you may make copies as only provided below. You may
not copy the printed materials accompanying the SOFTWARE PRODUCT. Restrictions on use.
Licensee may not distribute copies of the SOFTWARE or accompanying materials to others.
Licensee may not modify, adapt, translate, reverse engineer, decompile, disassemble, or create
derivative works based on the SOFTWARE or its accompanying printed or written materials.
Transfer restrictions. Licensee shall not assign, rent, lease, sell, sublicense, or otherwise
transfer the SOFTWARE to another party without prior written consent of Sound Devices, LLC.
Any party authorized by Sound Devices, LLC to receive the SOFTWARE must agree to be bound
by the terms and conditions of this agreement.

Termination

Without prejudice to any other rights, Sound Devices, LLC may terminate this EULA if you fail to
comply with the terms and conditions of this EULA. In such event, you must destroy all copies
of the SOFTWARE PRODUCT and all of its component parts.
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Limited Warranty

No warranties. Sound Devices, LLC expressly disclaims any warranty for the SOFTWARE
PRODUCT. The SOFTWARE PRODUCT and any related documentation is provided “as is” without
warranty or condition of any kind, either express or implied, including, without limitation, the
implied warranties and conditions of merchantability, fithess for a particular purpose, or
non-infringement. The entire risk arising out of use or performance of the SOFTWARE PRODUCT
remains with you. No liability for damages. In no event shall Sound Devices, LLC or its suppliers
be liable for any damages whatsoever (including, without limitation, damages for loss of
business profits, business interruption, loss of business information, or any other pecuniary
loss) arising out of the use of or inability to use this Sound Devices, LLC product, even if Sound
Devices, LLC has been advised of the possibility of such damages. In any case, Sound Devices,
LLC’s entire liability under any provision of this evaluation license shall be limited to the greater
of the amount actually paid by you for the SOFTWARE PRODUCT or U.S. $5.00. Because some
states/jurisdictions do not allow the exclusion or limitation of liability for consequential or
incidental damages, the above limitation may not apply to you.

Governing Law
This agreement and limited warranty are governed by the laws of the state of Wisconsin.

FCC Compliance Statement F(C

This device complies with part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation. FCC Part
15.19 (a) (3)

Changes or modifications not expressly approved by the party responsible for compliance could
void the user’s authority to operate the equipment.

FCC Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses and
can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference by one or
more of the following measures:

» Reorient or relocate the receiving antenna.

» Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver
is connected.

» Consult the dealer or an experienced radio/TV technician for help.

This device complies with FCC and ISED RF Exposure SAR limits exposure limits for general
population / uncontrolled exposure.

This Device complies with Industry Canada License-exempt RSS standard(s). Operation is
subject to the following two conditions: 1) this device may not cause interference, and 2) this
device must accept any interference, including interference that may cause undesired operation
of the device.
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Sound Devices, LLC

E7556 Road 23 and 33
Reedsburg, Wisconsin 53959
USA

Phone: +1 (608) 524-0625
Fax: +1 (608) 524-0655

Customer Support
Toll Free: (800) 505-0625

Email: support@sounddevices.com
http://Iwww.sounddevices.com/support

http:/forum.sounddevices.com

Product Information

For more information about products
and accessories, visit us on the web at
www.sounddevices.com.
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